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FEATURE ARTICLE

YOU ASKED, WE DELIVERED: WATCH 
NEW ENHANCEMENTS VIDEO 

Are you too busy to attend a webinar, but would like to know more about recent enhancements to the Cigna 
for Health Care Professionals website (CignaforHCP.com)? In less than five minutes, you can watch a video 
and learn about the exciting changes we recently made. 

Based on your feedback, we added new features to give you more detailed benefit information, and options 
to obtain a reference number and save your search. We also added new functionality to help you more easily 
resolve claim issues via the website, and request an adjustment or an appeal online.  

Watch the short video

Go to CignaforHCP.com > Get questions answered: Resource > Medical Education and Training > 
CignaforHCP.com 2020 Enhancements. You may also want to explore additional videos on the 
Medical Education and Training web page that provide further details about the new features.  
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https://cignaforhcp.cigna.com/app/login
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POLICY UPDATES

PREVENTIVE CARE SERVICES 
POLICY UPDATES 

On March 1, 2021 and April 15, 2021, updates became effective for Cigna's Preventive Care Services 
Administrative Policy (A004).

Summary: Preventive care updates effective on March 1, 2021

DESCRIPTION UPDATE CODES

Hepatitis C screening Changed from one-time screening for adults at 
risk of infection (those born between 1945-1965) 
to all adults age 18-79, including women with a 
maternity diagnosis 

Affects two Current Procedural Terminology (CPT®) 
codes and one Healthcare Common Procedure 
Coding System (HCPCS) code 

86803 or 87522 with a 
designated wellness code 
from Code Group 1 or with a 
maternity diagnosis code 

G0472 with any diagnosis code

Breastfeeding 
equipment

Removed reference to CareCentrix; eviCore 
healthcare (eviCore) is now the durable medical 
equipment (DME) ancillary provider

N/A

High blood pressure 
equipment

Removed reference to CareCentrix; eviCore is now 
the DME ancillary provider

N/A

Summary: Preventive care updates effective on April 15, 2021

DESCRIPTION UPDATE CODES

Prostate cancer 
screening

Lowered screening age for asymptomatic men from 
age 50 to age 45 

N/A

For additional guidance on preventive care services, refer to the Preventive Care Services Administrative 
Policy (A004) on the Cigna for Health Care Professionals website (CignaforHCP.com) > Review coverage 
policies > Medical and Administrative A-Z Index > Preventive Care Services – (A004).
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POLICY UPDATES

CLINICAL, REIMBURSEMENT, AND 
ADMINISTRATIVE POLICY UPDATES 
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To support access to quality, cost-effective care for your patients with a medical plan administered by Cigna, we routinely review clinical, reimbursement, and administrative policies for potential updates. As a reminder, 
reimbursement and modifier policies apply to all claims, including those for your patients with “G” ID cards.

Planned medical policy updates*

POLICY NAME DESCRIPTION OF SERVICE UPDATE EFFECTIVE DATE 

Diagnostic Nasal/
Sinus Endoscopy, 
Functional 
Endoscopic Sinus 
Surgery (FESS) and 
Turbinectomy (0554) 

FESS is a minimally invasive surgical technique used to clear sinus blockages and 
make breathing easier. FESS may be necessary for people with recurrent sinusitis, 
sinus deformity, or abnormal growths in the sinuses for which nonsurgical treatments 
have failed.

A turbinectomy is a surgical procedure that removes some or all of a patient’s turbinates 
(small bony structures that occur inside the nose).

We will implement a new medical coverage policy, Diagnostic Nasal/
Sinus Endoscopy, Functional Endoscopic Sinus Surgery (FESS) 
and Turbinectomy (0554), to review claims for these procedures for 
medical necessity. 

July 10, 2021 for dates of 
service on or after this date.

Intraoperative 
Monitoring (0509)

Intraoperative monitoring (IOM) is an umbrella term used to describe a variety of 
electrodiagnostic tests that monitor the integrity of neural pathways during surgical 
procedures when there may be risk of damage to the brain, spinal cord, or nerve.

We will review claims for IOM services billed with certain cervical spine 
surgeries and deny them as not medically necessary when appropriate.

This update excludes surgeries for traumatic injury, tumor, and complex 
spinal instrumentation. 

July 12, 2021 for dates of 
service on or after this date.

Facility Routine 
Services, Supplies and 
Equipment – (R12)

A blood draw is a procedure in which blood is taken from a patient. 

Venipuncture is the puncture of a vein as part of a medical procedure to withdraw a 
blood sample.

We will update the way we process outpatient facility blood draw and 
venipuncture claims to deny services billed with Current Procedural 
Terminology (CPT®) codes 36400, 36405, 36406, 36410, 36415, 36416, 
36591, and 36592, because reimbursement for these routine services is 
included in the facility payment.

September 12, 2021 for claims 
processed on or after this 
date.

Continued on next page * Please note that the planned updates are subject to change. For the most up-to-date information, please visit CignaforHCP.com.

https://static.cigna.com/assets/chcp/pdf/coveragePolicies/medical/mm_0554_coveragepositioncriteria_FESS_turbinectomy.pdf
https://static.cigna.com/assets/chcp/pdf/coveragePolicies/medical/mm_0554_coveragepositioncriteria_FESS_turbinectomy.pdf
https://static.cigna.com/assets/chcp/pdf/coveragePolicies/medical/mm_0554_coveragepositioncriteria_FESS_turbinectomy.pdf
https://cignaforhcp.cigna.com/app/login
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Additional information
Coverage policies

To view our coverage policies, including an outline of monthly coverage policy changes and a 
full listing of medical coverage policies, visit the Cigna for Health Care Professionals website 
(CignaforHCP.com) > Review Coverage Policies. 

Reimbursement and modifier policies

To view our reimbursement and modifier policies, log in to CignaforHCP.com. Go to Resources > 
Clinical Reimbursement Policies and Payment Policies > Reimbursement and Modifier Policies. If 
you are not registered for the website, go to CignaforHCP.com and click Register. 

POLICY UPDATES

Clinical, reimbursement, and administrative  
policy updates continued

OTHER IMPORTANT UPDATES

Effective July 1, 2021 

Arthroplasty, arthrodesis, and laminectomy level of care review

The Centers for Medicare & Medicaid Services (CMS) and evidence-based guidelines from MCG 
Health designate procedures with CPT codes 27702, 27870, and 63045 as outpatient when 
medically appropriate. In keeping with this standard, for dates of service on or after July 1, 2021, 
Cigna may deny coverage for these procedures when requested at the inpatient level of care. 
Denials will include medical necessity appeal rights.

We will require precertification to determine the medically necessary and appropriate level of care 
for these procedures, and base our review of medical necessity on MCG criteria. 

Effective October 1, 2021

Spinal fusion level of care review

CMS and evidence-based guidelines from MCG guidance designate CPT codes 22558, 22612, 22600, 
22630, 22633, and 22856 as outpatient when medically appropriate. In keeping with this standard, 
for dates of service on or after October 1, 2021, we will require precertification to determine the 
medically necessary and appropriate level of care for these procedures, and base our review of 
medical necessity on MCG criteria.

Effective October 16, 2021

Venipuncture billed with certain lab codes 

As a result of a recent review, and consistent with industry standards for venipuncture 
reimbursement, we will deny CPT code 36415 when billed with certain lab codes as incidental. The 
method of obtaining the sample is integral to performing the laboratory analysis when reported by 
the same provider.

This update excludes claims billed with modifier 59 and national lab Taxpayer Identification Numbers.

https://cignaforhcp.cigna.com/app/login
https://static.cigna.com/assets/chcp/resourceLibrary/coveragePolicies/index.html
https://cignaforhcp.cigna.com/app/login
https://cignaforhcp.cigna.com/app/login
https://cignaforhcp.cigna.com/app/registration/lob


POLICY UPDATES

PRECERTIFICATION UPDATES 
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To help ensure that we are administering benefits properly, we routinely review our precertification policies 
for potential updates. As a result of a recent review, we want to make you aware that we have updated our 
precertification list.

Codes added to the precertification list in July 2021 

On July 1, 2021, we added nine new and two existing Current Procedural Terminology (CPT®) codes, and 
15 new and 12 existing Healthcare Common Procedure Coding System (HCPCS) codes.

Codes removed from the precertification list in July 2021

On July 1, 2021, we removed one existing CPT code and five HCPCS codes from the precertification list that 
no longer require precertification.  

To view the complete list of services that require precertification of coverage, click here. Or, log 
in to the Cigna for Health Care Professionals website (CignaforHCP.com) > Resources > Clinical 
Reimbursement Policies and Payment Policies > Precertification Policies. If you are not registered 
for the website, go to CignaforHCP.com and click Register.

ELECTRONIC TOOLS

ENHANCEMENTS TO ONLINE CLAIM 
RECONSIDERATION FEATURE 
Did you know you can submit claim reconsideration 
requests and appeals via the Cigna for Health Care 
Professionals website (CignaforHCP.com)? By using 
this feature, you can:

›	 Avoid having to call Customer Service to request 
an adjustment.

›	 Save time – no need to mail or fax your request 
and documentation.

›	 Use the notes section to explain your request.

›	 Upload attachments easily for requests that 
require supporting documentation.

›	 Confirm that your request has been received.

›	 Check the status of your request online.

Now the feature is even easier to use
We listened to your feedback, and made it even 
easier to submit a claim reconsideration request or 
appeal on CignaforHCP.com. The process is now 
more relevant and simple, requiring less review 
and clicks. If you haven’t yet submitted a claim 
reconsideration or appeal request online, now’s a 
great time to start. 

Registered users of the website with the appropriate 
access can request a(n):

›	 Appeal for a precertification decision  
(pre-service).

›	 Appeal for a finalized claim.

›	 Simple adjustment. 

* Or go to CignaforHCP.com > Get questions answered: Resource > Medical Education and Training > Online Claims Reconsideration.

Access to the feature
Speak with your website access manager if you 
need access to the feature. To submit or check the 
status of appeals for precertification decisions, 
you must be able to view eligibility and benefit 
information for patients, as well as have access 
to the “Precertification” website entitlement. To 
submit claim appeals or reconsideration requests, 
you must be able to view claims on the site and 
have access to the “Reconsideration” website 
entitlement.

Learn more about the feature
Watch a short video* for more details about 
the feature.  

https://www.cigna.com/static/www-cigna-com/docs/individuals-families/master-precertification-list-for-providers.pdf
https://cignaforhcp.cigna.com/web/public/guest
https://cignaforhcp.cigna.com/web/public/guest
https://cignaforhcp.cigna.com/spa/chcp/registration/lob
https://cignaforhcp.cigna.com/app/login
https://cignaforhcp.cigna.com/app/login
https://cignaforhcp.cigna.com/app/login
https://link.videoplatform.limelight.com/media/?mediaId=5496dbc0224a4206891105e4bb8df602&width=720&height=370&playerForm=LVPPlayer&embedMode=html&htmlPlayerFilename=limelightjs-player.js
https://link.videoplatform.limelight.com/media/?mediaId=5496dbc0224a4206891105e4bb8df602&width=720&height=370&playerForm=LVPPlayer&embedMode=html&htmlPlayerFilename=limelightjs-player.js


ELECTRONIC TOOLS

WEBINAR SCHEDULE FOR 
DIGITAL SOLUTIONS 
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You’re invited to join interactive, web-based demonstrations of the Cigna 
for Health Care Professionals website (CignaforHCP.com). Learn how to 
navigate the site and perform time-saving transactions such as eligibility 
and benefit inquiries, claim status inquiries, electronic funds transfer (EFT) 
enrollment, and more. There is also a special training session for website 
access managers. The tools and information you’ll learn about will benefit 
you and your patients with Cigna coverage.

Preregistration is required for each webinar 
(Please take note of the time zones for each session.) 
1.	 On the chart to the right, click the date of the webinar you’d like 

to attend.

2.	 Enter the requested information and click Register.

3.	 You'll receive a confirmation email with the meeting details, and links to 
join the webinar session and add the meeting to your calendar.

Three ways to join the audio portion of the webinar:
Option 1 – When you link to the webinar, “Call me” will appear in a 
window. If you have a direct outside phone line, you can click this option. 
You’ll receive a phone call linking you to the audio portion. 

Option 2 – Call 866.205.5379. When prompted, enter the corresponding 
Meeting Number shown on the right. When asked to enter an attendee ID, 
press #.

Option 3 – Call in using your computer. 	

Questions? 
Email: ProviderDigitalSolutions@Cigna.com

TOPIC DATE 
MEETING TIME IN U.S. TIME ZONES 
(EASTERN/CENTRAL/MOUNTAIN/PACIFIC)

LENGTH MEETING 
NUMBER

Website Access Manager Training Wednesday, July 28, 2021 12:00 PM/11:00 AM/10:00 AM/9:00 AM 60 min 129 734 7864

CignaforHCP.com Overview Wednesday, August 4, 2021 12:30 PM/11:30 AM/10:30 AM/9:30 AM 90 min 129 623 3402

Eligibility & Benefits/Cigna Cost of 
Care Estimator

Wednesday, August 11, 2021 12:00 PM/11:00 AM/10:00 AM/9:00 AM 60 min 129 960 1608

EFT Enrollment, Online Remittance, 
and Claim Status Inquiry

Monday, August 16, 2021 1:00 PM/12:00 PM/11:00 AM/10:00 AM 60 min 129 363 1421

Online Appeal and Claim 
Reconsideration

Wednesday, August 18, 2021 12:00 PM/11:00 AM/10:00 AM/9:00 AM 60 min 129 728 7261

Website Access Manager Training Monday, August 23, 2021 2:00 PM/1:00 PM/12:00 PM/11:00 AM 60 min 129 332 4604

CignaforHCP.com Overview Tuesday, September 7, 2021 2:00 PM/1:00 PM/12:00 PM/11:00 AM 90 min 129 159 2330

Eligibility & Benefits/Cigna Cost 
of Care Estimator

Thursday, September 16, 2021 1:00 PM/12:00 PM/11:00 AM/10:00 AM 60 min 129 855 9895

EFT Enrollment, Online Remittance, 
and Claim Status Inquiry

Monday, September 20, 2021 1:00 PM/12:00 PM/11:00 AM/10:00 AM 60 min 129 706 5462

Online Appeal and Claim 
Reconsideration

Thursday, September 23, 2021 9:30 AM/8:30 AM/7:30 AM/6:30 AM 60 min 129 839 8780

Website Access Manager Training Tuesday, September 28, 2021 2:00 PM/1:00 PM/12:00 PM/11:00 AM 60 min 129 993 5436

https://cignaforhcp.cigna.com/app/login
mailto:ProviderDigitalSolutions%40Cigna.com?subject=
https://cigna.webex.com/cigna/k2/j.php%3FMTID%3Dta526363366e9f00b62bbb55c626cd60a
https://cigna.webex.com/cigna/k2/j.php%3FMTID%3Dt7ec13d07ac28796ecb5e8e9428f1b7c4
https://cigna.webex.com/cigna/k2/j.php%3FMTID%3Dt449ca9922e4e7ac8644a09d58d7145f3
https://cigna.webex.com/cigna/k2/j.php%3FMTID%3Dt65ba69df3779264f4ae4288a6ed4e080
https://cigna.webex.com/cigna/k2/j.php%3FMTID%3Dt2aa15e954d1b1653fe489efa349b9d99
https://cigna.webex.com/cigna/k2/j.php%3FMTID%3Dtbeb4ae456064218d8ee8a19f9f6c193c
https://cigna.webex.com/cigna/k2/j.php%3FMTID%3Dt4b8510d10ecb0296fb213386061d3f34
https://cigna.webex.com/cigna/k2/j.php%3FMTID%3Dt875afdea26c204e7732e0f3935592267
https://cigna.webex.com/cigna/k2/j.php%3FMTID%3Dtba0ed7ca20e0362f0f8b450b1935a26f
https://cigna.webex.com/cigna/k2/j.php%3FMTID%3Dt9aa4a130480f014640ddf7e577d4eeb3
https://cigna.webex.com/cigna/k2/j.php%3FMTID%3Dt5a5d1ab0ce4fb9a9b4226cc0def83a1a


CONNECTED CARE 

HELP PATIENTS FIND RESOURCES 
TO SUPPORT THEIR CARE 
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You may have patients who want to adhere to your treatment plan, but who face barriers such as financial concerns, housing 
instability, food insecurity, or health illiteracy. They may not know where to turn for help and may appreciate your guidance, as their 
health care provider and someone they trust, about where to look for community resources.

Helping patients address their needs

During care discussions, consider encouraging your patients to log in to myCigna.com to learn more about how to:

›	 Price a medication or options for mail order delivery. 

›	 Research estimates for costs of care based on a variety of 
common conditions.

›	 Locate an urgent care facility or provider.

›	 Access telemedicine and virtual care options.

›	 Chat with a Cigna 24-Hour Health Information Line clinician. 

›	 Connect with a Cigna Benefit Specialist to review plan 
coverage, including copayments and deductibles.

›	 Contact Cigna Customer Service at the phone number on 
their ID card for further assistance.

AAFP community resource tools

The American Academy of Family Physicians (AAFP) offers free, web-based resources through The EveryONE Project to help you 
identify and address patients’ social health-related needs. 

RESOURCE DESCRIPTION HOW TO ACCESS

Neighborhood 
Navigator 

Providers and their patients can look up community resources 
and programs such as community food banks, job training, 
transportation, and legal aid.

AAFP.org > Family Physician > Patient Care > 
EveryONE Project > View Toolkit > The 
EveryONE Project Neighborhood Navigator

Social Needs 
Screening Tool

Providers can use this tool to screen for health-related social 
needs (housing, food, transportation, utilities, and personal 
safety) and other needs such as for employment, education, 
child care, and financial help.

AAFP.org > Family Physician > Patient Care > 
EveryONE Project > View Toolkit > Social 
Needs Screening Tools > Social Needs 
Screening Tool

Social Needs 
Patient Action 
Plan 

Providers can use this quick form (available in seven 
languages) to guide discussions with patients about their social 
determinants of health and creation of a plan to address them.

AAFP.org > Family Physician > Patient Care > 
EveryONE Project > View Toolkit > Action Plan 
Development Tools > Develop an Action Plan

https://my.cigna.com/web/public/guest
https://www.aafp.org/home.html
https://www.aafp.org/patient-care/social-determinants-of-health/everyone-project/neighborhood-navigator.html
https://www.aafp.org/patient-care/social-determinants-of-health/everyone-project/neighborhood-navigator.html
https://www.aafp.org/home.html
https://www.aafp.org/dam/AAFP/documents/patient_care/everyone_project/hops19-physician-form-sdoh.pdf
https://www.aafp.org/dam/AAFP/documents/patient_care/everyone_project/hops19-physician-form-sdoh.pdf
https://www.aafp.org/home.html
https://www.aafp.org/family-physician/patient-care/the-everyone-project/toolkit/assessment.html#action
https://www.aafp.org/family-physician/patient-care/the-everyone-project/toolkit/assessment.html#action


CONNECTED CARE 

ENGAGING WITH 
PATIENTS VIRTUALLY 

Health care continues to evolve rapidly, while affordability, fragmentation, and access issues persistently put 
quality care out of reach for too many. Recently, the COVID-19 pandemic became a new driver of change, 
bringing into focus a real-time need for more convenient, accessible, and safe health care options.

As a result, providers and their patients alike have shown a growing interest in staying connected through 
virtual care (or telehealth). To support this emerging need, we are committed to working with providers in 
their efforts to deliver care how, when, and where it best meets the needs of their patients.

* �Eric Herbek. “Virtual Care and Digital Health Are Here to Stay.” Evernorth. Retrieved from Evernorth.com > Insights > Article: Virtual Care and Digital Health Are Here to Stay.

Cigna's Virtual Care Reimbursement Policy

To help providers attract and retain patients, reduce 
access barriers, and provide the right care at the 
right time, our Virtual Care Reimbursement Policy 
allows for reimbursement of a variety of services 
typically performed in an office setting, but that 
are also appropriate to perform virtually. Services 
covered include routine appointments, new patient 
exams, behavioral assessments, and others. When all 
requirements of the policy are met, services remain 
reimbursed at face-to-face rates for virtual care 
provided to patients with Cigna commercial medical 
coverage as we continue to evaluate our virtual 
care reimbursement strategy in a post COVID-19 
environment. 

For complete details on the virtual care services 
we reimburse, billing requirements, and a copy of 
the full Virtual Care Reimbursement Policy, visit 
CignaforHCP.com/VirtualCare.

The future of virtual care

As demand for virtual care grows – with over 
75 percent of Americans* seeing a future of health 
care at home – virtual care rendered by Cigna 
network-participating providers will help us to 
collectively accelerate meaningful change and create 
a more patient-centered, connected health care 
experience. Ultimately, we want to build a better 
bridge to deliver coordinated care – in the setting 
customers prefer – for greater access to affordable, 
convenient, and safe care. 

Cigna network-participating providers play a vital 
role in these plans. We are excited about the future 
possibilities of virtual care and reimagining the 
end-to-end care experience together.
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https://www.evernorth.com/articles/virtual-care-and-digital-health-are-here-to-stay
http://home.healthcare.cigna.com/chchome/CRUintranet/admin_guidelines/modifiers_and_reimburse/R31_Virtual_Care.pdf
https://static.cigna.com/assets/chcp/resourceLibrary/medicalResourcesList/medicalDoingBusinessWithCigna/medicalDbwCVirtualCare.html
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NETWORK UPDATES

CIGNA + OSCAR PLANS EXPAND: 
CALIFORNIA AND CONNECTICUT 

Cigna and Oscar Health are committed to providing quality, cost-efficient health solutions for small employer 
groups. The Cigna + Oscar plans bring together the power of Cigna's national and local provider networks – 
Open Access Plus and Cigna LocalPlus® – and Oscar Health’s innovative digital customer experience.

These plans expanded to additional counties in California on April 1, 2021, and to Connecticut on July 1, 2021. 
Note that the Connecticut plans use only the Open Access Plus network.

Where Cigna + Oscar plans are offered
We offer Cigna + Oscar plans in the following markets:

STATE COUNTIES

California Alameda, Contra Costa, El Dorado, Kern, Los Angeles, Marin, Napa, Orange, Placer, Riverside, 
Sacramento, San Bernardino, San Diego, San Francisco, San Luis Obispo, San Mateo, Santa 
Barbara, Santa Clara, Solano, Sonoma, Ventura, and Yolo

Connecticut All

Georgia Banks, Barrow, Clarke, Dawson, Elbert, Franklin, Gilmer, Greene, Habersham, Hall, Hart, 
Jackson, Lumpkin, Madison, Metro-Atlanta, Morgan, Oconee, Oglethorpe, Pickens, Rabun, 
Rockdale, Stephens, Towns, Union, and White

Tennessee All

Providers that participate in the Cigna + Oscar network
You are considered a Cigna + Oscar network-participating provider if you participate in Cigna's:

›	 LocalPlus network in the California, Georgia, and Tennessee markets where Cigna + Oscar plans are 
offered, or 

›	 Open Access Plus network, regardless of state, county, or region.

To confirm your network participation, visit Oscar’s online directory at CignaOscar.com/search or call Oscar 
Customer Service at 855.672.2755 (option 4).  

  * CignaforHCP.com > Get questions answered: Resource > Medical Resources > Medical Plans And Products > Cigna + Oscar Plans.
** �	CignaforHCP.com > Get questions answered: Resource > Reference Guides > Medical Reference Guides > Cigna + Oscar plans: Supplemental guide and program requirements.

More information
To learn more about Cigna + Oscar plans, access the resources listed below.

›	 Cigna + Oscar provider website (CignaOscar.com)

›	 Cigna + Oscar web page on the Cigna for Health Care Professionals website*

›	 Additional Administrative Guidelines and Program Requirements for Cigna + Oscar Plans**

›	 Oscar Health Customer Service: 855.672.2755, select option 4

Be sure to watch for important updates about Cigna + Oscar plans in future issues of Network News.

http://www.hioscar.com/care-options
https://cignaforhcp.cigna.com/app/login
https://static.cigna.com/assets/chcp/resourceLibrary/medicalResourcesList/medicalPlansAndProduct/medicalPlansAndProductCignaPlusOscarPlans.html
https://cignaforhcp.cigna.com/app/login
https://assets.ctfassets.net/0eso7s4po5w7/4f3kNJoaqDBxEVHB7e3duz/03c474217d24114b7ca175f19356ad4f/C___O_Supplemental_Provide_Reference_Guide_-_Update_201012.pdf
https://www.hioscar.com/business/cigna?redirect=cignaoscar.com&
https://static.cigna.com/assets/chcp/resourceLibrary/medicalResourcesList/medicalPlansAndProduct/medicalPlansAndProductCignaPlusOscarPlans.html
https://assets.ctfassets.net/0eso7s4po5w7/4f3kNJoaqDBxEVHB7e3duz/03c474217d24114b7ca175f19356ad4f/C___O_Supplemental_Provide_Reference_Guide_-_Update_201012.pdf
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NETWORK UPDATES

CIGNA GENE THERAPY PROGRAM 

  * �Ned Pagliarulo. “FDA, expecting a gene therapy boom, firms up policies.” BioPharma Dive. 28 January 2020. Retrieved from  
https://www.biopharmadive.com/news/fda-gene-therapy-guidance-sameness-durability/571225/.

**	 Participating provider refers to providers who have amended their contracts to participate in the Cigna Gene Therapy Program.  

By 2025, the U.S. Food & Drug Administration (FDA) expects it will be reviewing and approving between 
10 and 20 cell and gene therapies each year.* To manage the quality and affordability of these emerging 
therapies, we introduced the Cigna Gene Therapy Program last year. The program directs customers to 
qualified participating providers.**

Expanding our list of participating providers

We are pleased to announce that additional providers have contracted with the Cigna Gene 
Therapy Program:

Children's Hospital Colorado Aurora, Colorado

Connecticut Children’s Medical Center Hartford, Connecticut

Morristown Memorial Hospital Morristown, New Jersey

To access the complete list of participating providers, log in to the Cigna for Health Care Professionals 
website (CignaforHCP.com) > Resources > Reimbursement and Payment Policies > Precertification 
Policies > Cigna Gene Therapy Program for Participating Providers.

Advanced cellular therapies to be added to the Cigna Reference Guide

In August 2021, we will expand the Cigna Gene Therapy Program section of the Cigna Reference Guide for 
physicians, hospitals, ancillaries, and other health care providers to address advanced cellular therapies, 
including chimeric antigen receptor (CAR) T-cell therapies. The revised section will be titled Gene and 
Advanced Cellular Therapy, and contain guidance for these innovative therapies.

Benefit plans may limit coverage to a select group of contracted providers. Cigna will contract, directly 
or indirectly, with select providers for each gene therapy and advanced cellular therapy, including CAR 
T-cell therapies.

Additional information
The Cigna Reference Guide for physicians, hospitals, ancillaries, and other health care providers includes 
additional information on gene therapy and the Cigna Gene Therapy Program. To access this guide, log 
in to CignaforHCP.com > Resources > Reference Guides > Medical Reference Guides: View Documents > 
Health Care Professional Reference Guides.

If you have questions about the Cigna Gene Therapy Program, contact your Cigna Contracting 
representative.

https://cignaforhcp.cigna.com/app/login
https://cignaforhcp.cigna.com/app/login
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CLINICAL NEWS 

HOME BLOOD PRESSURE 
MONITORING 

  * �Yuichiro Yano, MD, PhD; Donald M. Lloyd-Jones, MD, ScM. “USPSTF Recommendations for Screening for Hypertension in Adults; It is time to unmask hypertensive risk.” JAMA Cardiology. 
27 April 2021. Retrieved from https://JAMAnetwork.com/journals/jamacardiology/fullarticle/2779347. 

** �NCQA. “HEDIS Measurement Year 2020 & Measurement Year 2021 Volume 2: Summary Table of Measures, Product Lines and Changes.” Retrieved from NCQA.org > HEDIS > HEDIS 
Measures and Technical Resources > HEDIS Measurement Year 2021 > HEDIS MY 2020 & MY 2021 (pdf).

Since the start of the COVID-19 pandemic, there has been a shift from on-site office visits to virtual care 
(i.e., telehealth) visits. Virtual care is becoming integrated with traditional health care, and with it comes the 
opportunity to improve the quality of care. This may include offering some patients the option to take a 
more active role in their care, such as by taking their own blood pressure readings. 

Patient-reported blood pressure accepted 
by HEDIS

Patient home blood pressure monitoring can be a 
valuable way to identify hypertension – especially 
masked and white-coat hypertension.* Recognizing 
the changing health care landscape, the National 
Committee of Quality Assurance (NCQA) now 
accepts documentation of patient-reported blood 
pressure to meet Healthcare Effectiveness Data 
and Information Set (HEDIS®) medical record 
documentation.**

Patient education needed  
Clinical accuracy is key for valid blood pressure 
measurements. Carefully educate your patients 
who will be monitoring their blood pressure from 
home to ensure they record it accurately. 

›	 Discuss the importance of resting before the 
test, emptying the bladder, and using the right 
size cuff and correctly positioning it, as well as 
avoiding caffeine, smoking, and talking during 
the measurement. 

›	 Explain that if the first reading is high, they should 
wait a few minutes and take a second reading.

›	 Remind patients that it’s important to calibrate 
the monitoring device for clinical accuracy.

https://JAMAnetwork.com/journals/jamacardiology/fullarticle/2779347
https://www.ncqa.org/
https://www.ncqa.org/wp-content/uploads/2020/07/20200716_Summary_Table_of_Measures_Product_Line_and_Changes_UPDATED.pdf


REMINDER: UPDATE CONTACT 
INFORMATION VIA EMAIL 

REMINDER: WORKERS’ 
COMPENSATION, HMO, AND PPO 
PLANS IN FOCUS 

CIGNA HAS ENTERED INTO AN 
AGREEMENT WITH MITCHELL | 
GENEX | COVENTRY TO 
ACQUIRE QANI
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Cigna has entered into a definitive agreement 
with Mitchell | Genex | Coventry, a leader in cost 
containment technology, provider networks, clinical 
services, pharmacy benefit management (PBM), 
and disability management, to acquire Cigna’s 
QualCare Alliance Networks, Inc. (QANI), one of the 
largest managed care and workers’ compensation 
organizations serving the New Jersey, Pennsylvania, 
and New York tristate area. 

We anticipate the deal to close in the second half of 
2021, following applicable regulatory approvals and 
other customary closing conditions. Upon closing, 
QANI will become part of Coventry. 

Cigna acquired QANI in 2015, and since then, the 
organization has played a meaningful role in helping 
us continue our efforts to be a provider of choice to 
hospital systems and health care providers.    

We believe Coventry is the right company to 
continue QANI’s legacy of partnering with hospital 
systems to help enable success. Coventry is highly 
respected in the industry, and offers workers' 
compensation, auto and disability care, and cost-
management solutions for employers, insurance 
carriers, and third-party administrators.

We are focused on ensuring a smooth transition 
for employer groups, customers, and network 
providers. This acquisition will have no impact 
on Cigna's U.S. commercial employer groups, 
and until the closing, we will continue to operate 
business as usual. 

We will share additional details with providers as 
they become available.

QUALCARE NEWS

As a reminder, providers who participate in the QualCare network can update their contact information, 
including mailing address, phone number, and email address, by emailing QualCare Provider Relations at 
QCProvRel@QualCareinc.com. 

When you share your email address with us, you will receive future issues of Network News, as well as 
other important updates, directly to your email inbox. 

QualCare remains focused on workers’ compensation, as well as contracted health maintenance 
organization (HMO) and preferred provider organization (PPO) plans. The HMO and PPO networks 
continue to be active for your patients who access them through Oscar, Humana, and EmblemHealth.

Effective January 1, 2020, QualCare stopped offering administrative services only (ASO) plans. The 
runout period for claim adjudication ended on December 31, 2020, which means QualCare no longer 
processes ASO claims.

If you need to refund an employer group that was contracted with QualCare, please make the refund 
check payable to – and send it to – the employer group, not QualCare. If you need assistance obtaining 
the employer group name or address, please call QualCare Provider Services at 800.992.6613.

mailto:QCProvRel%40QualCareinc.com?subject=


To help ensure our customers have access to affordable, quality health care, on July 1, 2021, we made 
REMICADE® a nonpreferred-brand drug,2 and biosimilar products AVSOLA® and INFLECTRA® preferred-brand 
drugs for Cigna commercial customers. These changes will apply to customers with Individual & Family Plans 
beginning January 1, 2022.

PHARMACY NEWS

CHANGES TO CIGNA’S 
COVERAGE OF REMICADE 
EFFECTIVE JULY 1, 20211 
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1. For Texas- and Louisiana-insured customers, the effective date may be deferred until the plan renew date, as required by state law.
2. �If a provider believes the nonpreferred-brand drug is medically necessary, Cigna will review requests for a medical necessity exception. Providers can submit medical necessity review 

requests through their electronic health record or electronic medical record system, or through CoverMyMeds® or Surescripts®. Providers can also submit these requests to Cigna’s Coverage 
Review Department by telephone at 800.88Cigna (882.4462) or by fax at 855.840.1678.

3. �Information about these programs is taken from PfizerEncompass.com and AVSOLA.com. Cigna does not manage these programs. Patients should contact the assistance programs 
directly to confirm eligibility and details.

4. �Eligibility required. Terms and conditions apply. Federal and state health care beneficiaries are not eligible. Private insurance only. The Pfizer enCompass Co-Pay Assistance Program for 
INFLECTRA doesn’t cover or provide support for related supplies, services, or procedures. Full terms and conditions available at PfizerenCompass.com/HCP/Inflectra/find-patient-support.

5. �Terms, conditions, and program maximums apply. Other restrictions may apply. This program is not open to patients receiving prescription reimbursement under any federal, state, or 
government-funded health care program. Not valid where prohibited by law. The AVSOLA Co-Pay Card doesn’t cover or provide support for office visits or medication administration.

Copayment assistance for your patients

Your patients may be able to receive copayment 
assistance for INFLECTRA and AVSOLA:3

›	 Eligible customers enrolled in Cigna-administered 
commercial and Individual & Family Plans may be 
able to receive up to $20,000 per calendar year 
in copayment assistance, and may pay as little 
as $0 for each treatment through the Pfizer 
enCompass® Co-Pay Assistance Program for 
INFLECTRA.4 Patients can call 844.722.6672 
Monday through Friday from 8:00 a.m. to 
8:00 p.m. ET or go to PfizerEncompass.com > 
Patient > Inflectra: Submit to learn more.

›	 Patients can pay as little as $5 out of pocket for 
each treatment, up to the program maximum, 
with the AVSOLA Co-Pay Card.5 Patients can call 
866.264.2778 Monday through Friday from 9:00 
a.m. to 8:00 p.m. ET or go to the AVSOLA 
website (AVSOLAsupport.com) to learn more.

What this means to you and your patients 
who have Cigna coverage
Because REMICADE is no longer a preferred-brand 
drug, we encourage you to work with your patients 
to switch to AVSOLA or INFLECTRA. Our goal is 
to assist you in making this transition as seamless 
as possible. 

If your patient previously met medical necessity 
criteria for REMICADE through Cigna, as of  
July 1, 2021: 

›	 You can administer either INFLECTRA or 
AVSOLA without the need for further action 
provided there is no change to dosing, frequency, 
or site of service. 

›	 An authorization for INFLECTRA or AVSOLA will 
be effective from July 1, 2021, to May 1, 2022. You 
may call the Cigna Coverage Review Department 
at 800.88Cigna (882.4462) to receive a letter 
confirming this authorization.

Additional information

For assistance with procurement, please call CuraScript SD at 877.599.7748, Accredo, a Cigna 
specialty pharmacy, at 866.759.1557, or another participating specialty pharmacy.

https://www.pfizerencompass.com/
https://www.avsola.com/
https://www.pfizerencompass.com/hcp/inflectra/find-patient-support
https://www.pfizerencompass.com/
https://www.pfizerencompass.com/patient/inflectra/right-patient-support
https://avsolasupport.com/


PHARMACY NEWS

THERAPEUTIC CONTINUOUS 
GLUCOSE MONITORS 
COVERAGE CHANGE 

Effective July 1, 2021, we changed how we cover therapeutic continuous glucose monitors* (CGMs) for 
Cigna customers who have both medical and pharmacy coverage. For these customers, we cover all 
components of therapeutic CGMs (sensors, transmitters, and readers/receivers) under the pharmacy 
benefit, and may no longer cover therapeutic CGMs filled through a durable medical equipment (DME) 
or medical supply vendor under the medical benefit. 

What this means to DME and medical 
supply vendors

DME and medical supply vendors must request 
precertification for any therapeutic CGM orders 
they receive for Cigna customers. During the 
precertification process, we will determine medical 
necessity and identify whether the therapeutic 
CGM is covered under the customer’s medical or 
pharmacy benefit.

Nontherapeutic CGMs will continue to be 
covered under the medical benefit and require 
precertification.

Additional information

If you have questions, call Cigna Customer Service 
at 800.88Cigna (882.4462).

ONCOLOGY CLINICAL 
TRIAL MANAGEMENT 
Cigna and eviCore healthcare (eviCore) 
understand the importance of medical 
oncology clinical trials. Not only do they help 
with the discovery and perfection of new 
disease treatments, detection, and prevention, 
clinical trials give patients access to treatment 
options before they become widely available. 

That is why Cigna and eviCore are continuing 
to develop a comprehensive oncology clinical 
trial management solution that promotes 
affordability, predictability, and simplicity.

Clinical trial prior authorization update

Currently, Cigna manages outpatient prior 
authorization requests for medical oncology 
clinical trials. On August 13, 2021, eviCore 
will begin managing these requests for both 
pediatric and adult patients. Beginning on this 
date, you should request prior authorization for 
all outpatient medical oncology clinical trials on 
the eviCore website (eviCore.com).

Cigna will continue to perform utilization 
management for all inpatient adult and 
pediatric oncology cases.

Clinical trial matching

On April 15, 2021, eviCore enhanced its medical 
oncology prior authorization process to include 
a search of the National Cancer Institute’s 
oncology clinical trial database to help match 
patients to clinical trials. Providers have the 
opportunity to receive more information on 
any of the search results for consideration and 
discussion with their patients.
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* �This change applies to Dexcom G6 and Abbott FreeStyle Libre therapeutic CGMs. There is no change in coverage for nontherapeutic CGMs. Certain CGMs are approved by the U.S. Food 
& Drug Administration with a product classification known as “therapeutic.” This classification means the device is indicated for use as a nonadjunctive device that replaces information 
obtained by a standard home blood glucose monitoring system.

What this means to providers

For patients with Cigna medical and pharmacy 
coverage, providers must send prescriptions for all 
components of therapeutic CGMs to a participating 
retail pharmacy or to Express Scripts® Pharmacy, 
our home delivery pharmacy.

For patients with new therapeutic CGM needs, we 
recommend first checking for Cigna pharmacy 
coverage by submitting a prescription to their 
preferred pharmacies. Most major pharmacy benefit 
managers and plans cover therapeutic CGMs under 
the pharmacy benefit. Patients who are new to 
therapy will be subject to both prior authorization 
and quantity limits.

Additional information

eviCore performs utilization management review 
of most outpatient oncology cases to ensure 
adherence to Cigna’s Oncology Medications 
coverage policy (1403). To access this policy, go 
to the Cigna for Health Care Professionals website 
(CignaforHCP.com) > Review coverage policies > 
Pharmacy (Drugs & Biologics) A-Z Index > 
Oncology Medications - (1403).

If you have any questions, please call Cigna 
Customer Service at 800.88Cigna (882.4462).

https://www.evicore.com/
https://cignaforhcp.cigna.com/app/login
https://static.cigna.com/assets/chcp/pdf/coveragePolicies/pharmacy/ph_1403_coveragepositioncriteria_oncology.pdf


PHARMACY NEWS

SPECIALTY MEDICAL 
INJECTABLES WITH 
REIMBURSEMENT RESTRICTION 

Now you can find the opioid tools and information you need to support your patients – all in  
one central location: The Cigna Opioid Resources web page. You can access this web page by going to 
the Cigna for Health Care Professionals website (CignaforHCP.com) > Resource > Pharmacy  
Resources > Pharmacy Clinical Programs > Opioid Resources. 

OPIOID RESOURCES REFRESHED 
ON CIGNAFORHCP.COM 
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Our Specialty Medical Injectables with 
Reimbursement Restriction guidelines state that 
certain injectables must be dispensed and their claims 
must be submitted by a Cigna-contracted specialty 
pharmacy, unless otherwise authorized by Cigna.

The reimbursement restriction:

›	 Applies when the specialty medical injectable is 
administered in an outpatient hospital setting.

›	 Applies to specialty medical injectables covered 
under the customer’s medical benefit. Coverage 
is determined by the customer’s benefit plan.

›	 Does not apply when the specialty medical 
injectable is administered in a provider’s office, 
nonhospital-affiliated ambulatory infusion suite, 
or home setting.

Specialty Medical Injectables with 
Reimbursement Restriction list expansion
We recently expanded the Specialty Medical 
Injectables with Reimbursement Restriction list to 
include the specialty medical injectables listed below.

NAME DATE ADDED

EVKEEZA™  
(evinacumab-dgnb)*

March 2021

AMONDYS 45 (casimersen)* April 2021

EXONDYS 51 (eteplirsen) July 2021

VILTEPSO® (viltolarsen) July 2021

Additional information

To access the Specialty Medical Injectables 
with Reimbursement Restriction list, log in to 
the Cigna for Health Care Professionals website 
(CignaforHCP.com) > Resources > Reimbursement 
and Payment Policies > Precertification Policies > 
List of Specialty Medical Injectables With 
Reimbursement Restriction. We recommend you 
review this list frequently, as it is subject to change. 
Specialty medical injectables may be added upon 
U.S. Food & Drug Administration approval.

* �Cigna may grant an exception to reimburse a one-time or single administration billed by a facility when a customer needs access to the injectable before it can be obtained from a specialty 
pharmacy with which Cigna has a reimbursement arrangement.

Designed to help you support patient needs
Each of these sections links to many tools and 
resources for you and your staff to learn more 
about opioid addiction, prevention, and treatment. 
They’re designed to support your efforts to safely 
meet your patients’ needs. 

For example, when you click on "Patient 
education materials,” you’ll see a number of  
tools available to help you discuss the benefits, 
risks, and alternatives with your patients prior  
to prescribing opioids. 

Working together to decrease opioid 
addiction and deaths
Cigna is firmly committed to fighting the opioid 
epidemic and finding new pathways to help 
reduce addictions, overdoses, and deaths. 
Thank you for the critical role you play in 
addressing this public health crisis. 

What’s on the web page?
The Opioid Resources web page is structured in 
an easy-to-understand format to help you quickly 
find resources for:

›	 Screening tools.

›	 Patient and caregiver support.

›	 Treating pain safely.

›	 Preventing overdoses – taper, playbook, 
pledge.

›	 Getting help for addiction.

›	 Medication-assisted treatment (MAT). 

›	 Provider education. 

›	 Centers for Disease Control and Prevention 
information. 

https://cignaforhcp.cigna.com/app/login
https://static.cigna.com/assets/chcp/resourceLibrary/pharmacyResources/opioid-resources.html
https://cignaforhcp.cigna.com/app/login


MEDICARE NEWS

REMINDER: 2021 CIGNA MEDICARE 
ADVANTAGE PLAN HIGHLIGHTS 

New benefits to meet your patients' needs

2021 brings new benefits and services for your Cigna Medicare Advantage patients, with more 
comprehensive coverage, affordable and predictable out-of-pocket costs, and extended health benefits to 
help your patients access the care they need, when they need it.

More flexibility and stability to get patients healthier  
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96% 
will have a flat or  
reduced premium

Nearly 100%
will have fitness, dental, eyewear, 
meal, and hearing aid benefits

94% 
will have a $0 primary care 
provider (PCP) copayment

85%
will have an  

over-the-counter benefit

75% 
will have access to a 

transportation benefit 

73% 
will have  

a $0 premium plan

New 2021 benefits for all your Cigna Medicare Advantage patients

›	 $0 copayment behavioral health 
Patients have access to affordable behavioral specialty and psychiatric care at a $0 copayment, eliminating 
financial barriers for individual and Employer Group Waiver Plan patients.

›	 No-cost 24/7 online wellness resources 
This includes general wellness and prevention, disease management, fitness and exercise, men’s and 
women’s health, smoking cessation, weight management, advanced care planning, senior health, and more.

›	 Telehealth for physical therapy (PT)  
This benefit is in addition to our behavioral health and primary care telehealth services. Any participating 
PT provider who offers telehealth can use it; cost share is the same as in-person PT.

Reaching more communities 

In 2021, Cigna will offer plans in 369 counties spanning 23 states, representing a 22 percent increase in our 
county footprint. We will expand to 67 new counties, and include a broad portfolio of health maintenance 
organization (HMO) and preferred provider organization (PPO) plans. In addition to the new county 
expansion, we will expand PPO offerings in 154 counties in our existing footprint. PPO plans typically offer 
an out-of-network benefit, while HMO plans generally do not. 

Cigna will enter markets in five new states in 2021 with Medicare plans: 

›	 New Mexico (Albuquerque area) 

›	 Ohio (Liberty Valley/Cleveland) 

›	 Oklahoma (Oklahoma City area) 

›	 Utah (Salt Lake City area) 

›	 Virginia (Tri-Cities area in the southwest part of the state) 

This expansion builds on Cigna’s 2020 footprint, which currently serves more than 550,000 Medicare 
customers across 21 states and the District of Columbia. 

Continued on next page 



MEDICARE NEWS

Reminder: 2021 Cigna Medicare Advantage  
plan highlights continued

New plan names
Last year, we embarked on a new chapter of our Medicare business. We transitioned the Cigna-
HealthSpring brand to Cigna for our Medicare Advantage, Part D, and Texas Medicare-Medicaid plans. 
Here’s an overview of new plan names now in effect.

2020 2021

Cigna-HealthSpring Advantage (HMO) Cigna Fundamental Medicare (HMO)

Cigna-HealthSpring Preferred AL (HMO) Cigna Preferred AL Medicare (HMO)

Cigna-HealthSpring Preferred Plus (HMO) Cigna Preferred Plus Medicare (HMO)

Cigna-HealthSpring TotalCare (HMO D-SNP) Cigna TotalCare (HMO D-SNP)

Cigna-HealthSpring True Choice (PPO) Cigna True Choice Medicare (PPO)

Cigna-HealthSpring Achieve Plus (HMO C-SNP) Cigna Achieve Medicare (HMO C-SNP)

Cigna-HealthSpring Preferred Part B Savings (HMO) Cigna Preferred Savings Medicare (HMO)
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[Customer Service <--Toll Free Number ---> (TTY 711)]

947176

INT_21_89712_C

New 2021 ID cards
Cigna Medicare Advantage patients received new ID cards with the Cigna logo. Sample ID cards are 
shown below.

CIGNA MEDICARE ADVANTAGE WEB PAGE FOR PROVIDERS
We continue to enhance the Cigna Medicare Advantage web page for providers with new 
capabilities and features to improve your online experience when administering these plans. 
Visit MedicareProviders.Cigna.com for important tools and information, including:

›	 Provider manuals 

›	 Regulatory Highlights Guide 

›	 COVID-19 resources 

›	 Prior authorization guidelines 

›	 Medicare Advantage Quick Reference Guide 

›	 Sample explanation of payment 

›	 Behavioral health clinical practice guidelines 
and referral forms 

›	 HSConnect provider portal 

›	 Claim resources

›	 Network interest forms 

›	 Part B drugs/biologics precertification forms 
and step therapy

›	 Practice support

›	 Pharmacy resources 

›	 Provider education and assessment tools 

›	 Network Insider Medicare Advantage provider 
newsletter archive 

https://medicareproviders.cigna.com/
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DO YOU FEEL STUCK 
PRESCRIBING OPIOIDS? 
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1. �Boscarino JA et al. “Prevalence of prescription opioid-use disorder among chronic pain patients: comparison of the DSM-5 vs. DSM-4 diagnostic criteria. Jul–Sep 2011. National Library of 
Medicine. Retrieved from https://pubmed.ncbi.nlm.nih.gov/21745041/.

2. �“Opioid Treatment Programs (OTP).” 16 March 2021. Centers for Medicare & Medicaid Services. Retrieved from CMS.gov > Medicare > Medicare Fee-for-Service Payment: Opioid 
Treatment Programs (OTP).

3. https://pcssnow.org > Education & Training.
4. DrugAbuse.gov/taps. 
5. JHHC.com > For Providers > Resources & Guidelines > Substance Abuse Assessment Tool (CAGE).

Many providers find themselves facing the dual challenge of treating chronic pain effectively in their patients 
age 65 and older, while striving to address or prevent opioid use disorder (OUD) in this population.

Opioid resources and tools 

Cigna Opioid Resources provider web page

Visit the new Opioid Resources provider web page 
on the Cigna for Health Care Professionals website 
(CignaforHCP.com) > Resource > Pharmacy 
Resources > Pharmacy Clinical Programs > Opioid 
Resources, to support your patients – all in one 
location. To learn more, read the article on page 17. 

Behavioral Health Community-Based 
Care Coordinator

To connect your patients with Cigna Medicare 
Advantage network-participating providers and 
facilities that offer OUD medication-assisted 
treatment, contact Cigna's dedicated Medicare 
Advantage Community-Based Care Coordinator 
team. Call 866.780.8546 or fax clinical information 
to 866.949.4846.

Web-based education 

There are many screening tools available to help 
recognize OUD, including the following free 
web-based education courses:

›	 Providers Clinical Support System (PCSS) 
Education & Training3

›	 Tobacco, Alcohol, Prescription medication, and 
other Substance use (TAPS) Tool4

›	 CAGE-AID Substance Abuse Screening Tool5

OUD screening

In the primary care setting, it’s estimated that up to 
34.9 percent of people taking opioids for chronic 
pain meet the criteria for OUD.1 This highlights the 
critical importance of OUD screenings. 

Questions to ask your patients

›	 Have you ever taken more than your 
prescribed dose?

›	 When you don’t take your medication, do you 
experience any withdrawal symptoms?

›	 Have you ever asked another prescriber to refill 
your pain medications?

Depending on the responses to these questions, 
you may want to take steps to encourage patients 
to utilize an opioid treatment program (OTP). As of 
January 1, 2020, Medicare covers methadone and 
medication-assisted treatment, as well as related 
services provided by OTPs.2

Covered OTP services

To view OTP services that provide medication, 
counseling, drug testing, and individual and group 
therapy, go to Medicare.gov > What Medicare 
Covers > Is my test, item, or service covered? Then 
type Opioid Use Disorder; click Go > Opioid use 
disorder treatment services. 

https://pubmed.ncbi.nlm.nih.gov/21745041/
https://www.cms.gov/
https://www.cms.gov/medicare/medicare-fee-for-service-payment/opioid-treatment-program
https://www.cms.gov/medicare/medicare-fee-for-service-payment/opioid-treatment-program
https://pcssnow.org/
https://pcssnow.org/education-training/
https://www.drugabuse.gov/taps/#/
https://www.hopkinsmedicine.org/johns_hopkins_healthcare/
https://www.hopkinsmedicine.org/johns_hopkins_healthcare/downloads/all_plans/CAGE%20Substance%20Screening%20Tool.pdf
https://cignaforhcp.cigna.com/app/login
https://static.cigna.com/assets/chcp/resourceLibrary/pharmacyResources/opioid-resources.html
https://static.cigna.com/assets/chcp/resourceLibrary/pharmacyResources/opioid-resources.html
https://pcssnow.org/education-training/
https://pcssnow.org/education-training/
https://www.drugabuse.gov/taps/#/
https://www.drugabuse.gov/taps/#/
https://www.hopkinsmedicine.org/johns_hopkins_healthcare/downloads/all_plans/CAGE%20Substance%20Screening%20Tool.pdf
https://www.medicare.gov/
https://www.medicare.gov/coverage/opioid-use-disorder-treatment-services
https://www.medicare.gov/coverage/opioid-use-disorder-treatment-services
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MUSCULOSKELETAL 
PRECERTIFICATION NOW 
MANAGED BY EVICORE 
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On June 30, 2021, eviCore healthcare (eviCore) 
began to manage precertification reviews for the 
musculoskeletal (MSK) services listed below for our 
customers with Cigna Medicare Advantage plans. 

›	 Major joint services (hip, knee, and shoulder) 

›	 Interventional pain management procedures 

This precertification review is required in all 
markets, with the exception of Arizona, as well as 
some independent practice associations.

Precertification includes medical necessity 
and level-of-care reviews

As part of the precertification process, eviCore 
will conduct both a medical necessity review and 
a level-of-care review (if applicable). We require 
level-of-care reviews to help ensure customers with 
Cigna Medicare Advantage plan coverage receive 
the right care at the right place and at the right 
time. Note that coverage may be denied for some 
MSK large joint procedures when requested at the 
inpatient level of care.

  * Current Procedural Terminology.
** Go to https://www.evicore.com/resources/healthplan/Cigna-Medicare? > Solution Resources > Musculoskeletal. 

To view the most current 
precertification requirements

Visit MedicareProviders.Cigna.com > Forms 
and Practice Support > Prior Authorization 
Requirements. 

Need to know if a service requires 
precertification? 

Click Ctrl+F; then enter the five-digit code. The 
Prior Authorizations Requirements document 
is updated quarterly.

Large joint procedures that require  
level-of-care review

CATEGORY CPT®* CODE 

Large joint – hip 27130 

Large joint – knee 27438 

Large joint – knee 27446 

Large joint – knee 27447 

Large joint – shoulder 23470

Large joint – shoulder 23472

MSK CPT codes that require precertification

View the full list of MSK CPT codes for joint surgery 
and interventional pain management that require 
precertification for your patients with Cigna 
Medicare Advantage plans.** 

To request precertification

›	 eviCore provider portal: eviCore.com

›	 Phone: 888.693.3297, 8:00 a.m. to 9:00 p.m. ET

›	 Fax: 888.693.3210

To verify a patient’s eligibility and benefits

Call Provider Customer Service at 800.230.6138 
or visit the provider portal at MedicareProviders.
Cigna.com > Login to HSConnect Portal. 

https://www.evicore.com/resources/healthplan/Cigna-Medicare?
https://www.evicore.com/resources/healthplan/cigna-medicare?solutionid=31699923-93FB-44C1-B2FA-2897527C2D9D#solutiondocs
https://medicareproviders.cigna.com/
https://medicareproviders.cigna.com/forms
https://medicareproviders.cigna.com/forms
https://www.evicore.com/resources/healthplan/cigna-medicare?solutionid=31699923-93FB-44C1-B2FA-2897527C2D9D#solutiondocs
https://www.evicore.com/
https://medicareproviders.cigna.com/
https://medicareproviders.cigna.com/
https://www.hsconnectonline.com/login.aspx
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2022 PHYSICIAN QUALITY,  
COST-EFFICIENCY, AND CCD RESULTS

Cigna regularly evaluates physician quality and cost-efficiency information. Physicians who meet specific 
criteria, including those who participate in a Cigna Collaborative Care® program, can receive the Cigna Care 
Designation (CCD) for a given measured specialty. CCD denotes a higher-performing provider, based on the 
criteria outlined in the 2022 Quality, Cost Efficiency, and Cigna Care Designation Methodology white paper. 

In the coming months, we will mail information to primary care providers and specialists in 84 markets and 21 
specialties informing them how to obtain their 2022 quality, cost-efficiency, and CCD profile directory display 
results. The communication will give instructions on how to request reports, review results, submit inquiries, 
and submit changes or reconsideration requests. 

APA FREE COLLABORATIVE CARE 
MODEL TRAINING 
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* Psychiatry.org > Psychiatrists > Practice > Professional Interests > Integrated Care > Get Trained in the Collaborative Care Model.

The American Psychiatric Association (APA) is offering free training sessions about the collaborative 
care model for psychiatrists, primary care providers (PCPs), and behavioral health care managers as part 
of the Centers for Medicare & Medicaid Services Transforming Clinical Practice Initiative.

For more information and to register on the APA 
website (Psychiatry.org), click here.* 

Additional resources 

To learn more about the collaborative care model, 
including implementation, special populations, 
and training, visit Psychiatry.org > Psychiatrists > 
Practice > Integrated Care.

What is collaborative care?

Collaborative care is an evidence-based model of 
integrated mental health care in primary care 
settings. It shows clear and significant effectiveness 
for the treatment of depression, anxiety, and  
post-traumatic stress disorder. Widespread 
implementation of collaborative care is occurring 
across the country to answer the need for 
increased access to mental health and substance 
use disorder services.

Providers who take this training can earn continuing 
medical education credits, and are eligible to take 
part in a learning collaborative for continued 
education and maintenance of certification. 

About the training

The training for PCPs includes an overview of the 
collaborative care model, strengthening behavioral 
health skills in the primary care setting, and 
developing skills to work with psychiatric 
consultants. There is also a course to help 
behavioral care managers acquire the knowledge, 
skills, and attitudes that are crucial for their role in 
the primary care setting.

There is also a core training session that provides 
information on collaborative care consultation 
psychiatry. It focuses on the knowledge, skills, and 
attitudes necessary to help psychiatrists provide 
high-quality care for larger populations. This 
advanced training reviews the application of the 
integrated care approach.

https://www.cigna.com/static/www-cigna-com/docs/hcpdirectory/2022-cigna-care-designation.pdf
https://www.psychiatry.org/
https://www.psychiatry.org/psychiatrists/practice/professional-interests/integrated-care/get-trained
https://www.psychiatry.org/psychiatrists/practice/professional-interests/integrated-care/get-trained
https://www.psychiatry.org/
https://www.psychiatry.org/psychiatrists/practice/professional-interests/integrated-care/implement/special-populations
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EXPEDITED APPEAL 
SUBMISSION TIPS 

You may file an expedited appeal when:

›	 The patient is currently hospitalized, a decision 
was made to discharge the patient earlier than the 
provider requested, and the patient is awaiting 
continued care, or

›	 The patient is in severe pain that cannot be 
adequately managed without the treatment 
requested, or

›	 A delay in treatment may jeopardize the patient’s 
life, health, or ability to regain maximum 
functionality. 

How to request an expedited appeal

If your pre-service appeal meets one or more of the 
scenarios described above, fax the appeal to:

Cigna National Appeals Organization  
Attn: Expedited Appeals 

Fax: 860.731.3452

There may be times when you have an urgent need to appeal a coverage denial or partial coverage denial for 
your patient, and receive a decision very quickly to speed the start of treatment. In these situations, you may be 
able to request an expedited appeal, but only if services have not been performed and meet the criteria below. 

AMPLIFON HEARING HEALTH 
CARE INTRODUCES NEW 
REIMBURSEMENT MODEL 
Amplifon Hearing Health Care (Amplifon) is our 
exclusive national provider for digital and digitally 
programmable analog hearing aids and supplies 
and assistive listening devices for Cigna customers 
who have a hearing benefit.

On July 15, 2021, Amplifon changed the fitting and 
dispensing fees that they pay to Cigna-contracted 
providers for hearing aids and supplies. Amplifon 
shifted from a tiered schedule to a flat-rate 
reimbursement that compensates providers for 
the time they spend with their patients rather than 
for the hearing-aid technology level. The new rates 
are $500 per hearing aid or $1,000 per pair.

What this means to you

For hearing aids ordered on or after July 15, 2021, 
you will be reimbursed at the new rates. If you 
ordered hearing aids prior to this date, you will 
be reimbursed at the 2020 tiered rates ($250 

to $750 per hearing aid), provided that you 
submit the receipt-of-delivery (ROD) paperwork 
to Amplifon by July 30, 2021. If you submit the 
ROD paperwork after July 30, 2021, the new 
reimbursement rates will apply.

Before ordering hearing aids for your patients 
with Cigna coverage, call Amplifon at 
800.920.4327 to verify eligibility and benefits.

Hearing aid selection

Amplifon recently added new high-tech hearing 
aids to its selection of devices available to Cigna 
customers. For more information about available 
devices, call Amplifon at 800.920.4327.

Additional information

If you have any questions, call Amplifon 
at 800.920.4327 or email  
ProviderRelations@Amplifon.com.
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Clearly note “Expedited Appeal” on the first page 
of your submission. 

Please also include the following information:

›	 Patient name 

›	 Date of birth 

›	 Cigna ID # 

›	 Denied Authorization Number (if applicable)

›	 All supporting clinical information

mailto:ProviderRelations%40Amplifon.com?subject=
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MUSCULOSKELETAL  
SITE-OF-CARE REVIEW IN 
SELECTED GEOGRAPHIC AREAS 

On August 1, 2021, we will expand our precertification 
requirements for certain musculoskeletal (MSK) 
procedures to include a medical necessity review of 
the site of care. This requirement applies in select 
geographic areas, listed below, for Cigna commercial 
customers who have fully insured benefit plans.

›	 Arizona (Phoenix)

›	 Florida (South Florida)

›	 Missouri (St. Louis)

›	 New York (New York City)

We will review requests to ensure these customers 
receive coverage for an appropriate site of care, 
such as an ambulatory surgery center, rather than 
for an outpatient hospital setting (when available), 
except when an outpatient hospital setting is 
medically necessary. 

What this means to providers in the 
selected markets

eviCore healthcare (eviCore) will continue to manage 
the precertification process, including the site-of-
care review, and will approve:

›	 Precertification requests that include an 
appropriate site of care, and are in accordance 
with the terms of our coverage policy and the 
customer’s benefit plan.

include detailed information about the expanded 
precertification process, a review of how to access 
information on eviCore.com, and a question-and-
answer period.

To attend a forum, refer to the schedule and 
instructions for sign up at https://www.eviCore.com/
resources/healthplan/Cigna > Solution Resources > 
Musculoskeletal > Cigna Musculoskeletal Site of 
Care Provider Forum Schedule. 

View the policy

To access the Site of Care: Outpatient Hospital for 
Select Musculoskeletal Procedures policy, go to 
the Cigna for Health Care Professionals website 
(CignaforHCP.com) > Review coverage policies: 
information on Cigna standard health coverage plans 
provisions > Medical and Administrative A-Z index: 
View Documents > Site of Care: Outpatient Hospital 
for Select Musculoskeletal Procedures – (0553).

Next year, we will be implementing this policy in 
all geographic areas. 

Additional information

Please use the contact information below to 
learn more.

To learn more about: Contact:

MSK site-of-care 
program

Our dedicated program 
website:  
www.eviCore.com/
resources/healthplan/
Cigna

Precertification of 
MSK services

eviCore: 888.693.3297 
(7:00 a.m. to 7:00 p.m. 
ET) or clinical guidelines 
at eviCore.com

Benefits eligibility 
and coverage

Cigna Customer Service: 
800.88Cigna (882.4462)

›	 An outpatient hospital setting when medically 
necessary, as defined in the Site of Care: 
Outpatient Hospital for Select Musculoskeletal 
Procedures policy and the customer’s 
benefit plan.

Precertification process

You may continue to submit precertification requests 
to eviCore by logging in to the eviCore website 
(eviCore.com > PROVIDERS) or by calling eviCore at 
888.693.3297. During this process, if an outpatient 
hospital setting is indicated, eviCore will present the 
provider with a list of local participating ambulatory 
surgery centers to choose from. If the provider does 
not select an ambulatory surgery center as the place 
of service, he or she will have the option of attesting 
to medical necessity criteria for an outpatient 
hospital setting.

We will deny an outpatient hospital setting if the 
request does not provide clinical rationale or an 
attestation to medical necessity criteria for an 
outpatient hospital setting. Denials will be based 
on medical necessity and include medical necessity 
appeal rights.

Provider forums

In late July and August 2021, eviCore will host online 
forums to help providers and their staff understand 
our expanded MSK program. These sessions will 
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https://www.evicore.com/
https://www.evicore.com/resources/healthplan/cigna
https://www.evicore.com/resources/healthplan/cigna
https://www.evicore.com/-/media/files/evicore/microsites/implementation/cigna/evicore-msk-soc_onlineforumscheduleflyer.pdf
https://www.evicore.com/-/media/files/evicore/microsites/implementation/cigna/evicore-msk-soc_onlineforumscheduleflyer.pdf
https://cignaforhcp.cigna.com/app/login
https://static.cigna.com/assets/chcp/pdf/coveragePolicies/medical/mm_0553_coveragepositioncriteria_site_of_service.pdf
https://static.cigna.com/assets/chcp/pdf/coveragePolicies/medical/mm_0553_coveragepositioncriteria_site_of_service.pdf
https://www.evicore.com/resources/healthplan/Cigna
https://www.evicore.com/resources/healthplan/Cigna
https://www.evicore.com/resources/healthplan/Cigna
https://www.evicore.com/
https://static.cigna.com/assets/chcp/pdf/coveragePolicies/medical/mm_0553_coveragepositioncriteria_site_of_service.pdf
https://static.cigna.com/assets/chcp/pdf/coveragePolicies/medical/mm_0553_coveragepositioncriteria_site_of_service.pdf
https://static.cigna.com/assets/chcp/pdf/coveragePolicies/medical/mm_0553_coveragepositioncriteria_site_of_service.pdf
https://www.evicore.com/
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HIGH-TECH RADIOLOGY  
SITE-OF-CARE MEDICAL NECESSITY 
REVIEW PROGRAM EXPANSION 

On September 1, 2021, we will expand our precertification requirements for computed tomography scans 
and magnetic resonance imaging to include a medical necessity review of the site of care for customers with 
self-insured plans.* With this expansion, all Cigna commercial (non-Medicare) customers may be subject to 
this site-of-care medical necessity review.

We will review requests to ensure these customers receive coverage for an appropriate site of care, such as a 
freestanding facility, rather than for an outpatient hospital setting (when available), except in situations where 
the use of an outpatient hospital setting is medically necessary.**

What this means to you and your patients who have Cigna coverage

eviCore healthcare (eviCore) may perform a site-of-care medical necessity review. eviCore will approve:

›	 Precertification requests that include an appropriate site of care, and are in accordance with the terms of 
our coverage policy and the customer’s benefits.

›	 An outpatient hospital setting if there is clinical rationale, as defined in the Site of Care: High-tech Radiology 
policy and the customer’s benefit plan, or if an alternative site is not available.

Services subject to a site-of-care review will only be covered if both the procedure and the site are approved.

Precertification process

You may continue to submit precertification requests to eviCore by logging in to the eviCore website 
(eviCore.com > PROVIDERS) or by calling eviCore at 888.693.3297.
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  * We may not review the site of care in all geographic markets, pending regulatory approval and/or network considerations.
** Some hospitals with competitive costs will be exempt from the site-of-care review.

Additional information

Please use the resources listed below to learn more.

Topic Resource

Benefits eligibility and coverage Cigna Customer Service: 800.88Cigna (882.4462)

High-Tech Radiology Site of 
Care program

Our dedicated program website:  
www.eviCore.com/resources/healthplan/Cigna

Precertification of high-tech 
radiology services

eviCore: 888.693.3297 (7:00 a.m. to 7:00 p.m. ET) or clinical guidelines 
at eviCore.com

Site of Care: High-tech Radiology 
coverage policy

Cigna for Health Care Professionals website: CignaforHCP.com > Review 
coverage policies: information on Cigna standard health coverage plan 
provisions > Medical and Administrative A-Z Index: View Documents > 
Site of Care: High-tech Radiology - (0550)

https://www.evicore.com/
http://www.eviCore.com/resources/healthplan/Cigna
https://www.evicore.com/
https://cignaforhcp.cigna.com/app/login
https://static.cigna.com/assets/chcp/pdf/coveragePolicies/medical/mm_0550_coveragepositioncriteria_SOC_HTR.pdf
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ASH MANAGEMENT OF 
ACUPUNCTURE PROGRAM: 
NATIONAL EXPANSION 

Earlier this year, we announced that American Specialty Health® (ASH) would begin to manage Cigna’s 
acupuncture program nationally* on June 1, 2021. This effective date has been moved to September 1, 2021 to 
allow providers additional time for credentialing and contracting.

We will continue to administer covered in-network acupuncture services for Cigna customers under providers’ 
direct agreements with Cigna until August 31, 2021. 

What this means to providers

On September 1, 2021, providers must be contracted with ASH to render in-network acupuncture services to 
patients with Cigna plans.

Additional information

CIGNA QUALITY RESOURCES 
AVAILABLE ONLINE 
We want you to have the latest information about 
our quality initiatives and health management 
programs, care guidelines, and utilization 
management. We hope you find these resources 
helpful when considering care options for your 
patients with Cigna coverage.

Quality initiatives

The details of our quality initiatives are just a 
few clicks away on the Cigna for Health Care 
Professionals website (CignaforHCP.com) > 
Get questions answered: Resource > Medical 
Resources > Commitment to Quality > Quality.

Care guidelines

To view our care guidelines, visit  
CignaforHCP.com > Get questions 
answered: Resource > Medical Resources > 
Case Management/Health and Wellness > 
Care Guidelines.

Utilization management

We base utilization management decisions on 
appropriateness of care and services, standardized 
evidence-based criteria, and existence of 
coverage. We do not reward decision makers for 
issuing denials of coverage. There are no financial 
incentives in place for utilization management 
decision makers that encourage or influence 
decision-making. Your patients have the right to 
disagree with a coverage decision, and we will 
provide them with instructions on how to submit 
an appeal. Your patients can also elect to obtain 
care at their own expense. 

* For applicable service areas. ASH already manages this program for acupuncture providers in California, Oregon, Tennessee, and Washington.

IF YOU HAVE QUESTIONS ABOUT: CALL:

Contracting with ASH ASH: 888.511.2743

Acupuncture benefits or eligibility Cigna Customer Service: 800.88Cigna (882.4462)
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The following services are available to you and 
your patients, free of charge, when you submit a 
utilization management request:

›	 Language line services. 

›	 Telecommunications device for the deaf (TDD) 
and teletypewriter (TTY) services. Any deaf, 
hearing-impaired, or speech-impaired person in 
the United States can access these services 
through the 711 dialing code for the 
Telecommunications Relay Services (TRS), 
which interfaces with existing telephone 
equipment used by hearing-impaired persons.

If you have questions about our quality initiatives, 
including how we are progressing in meeting our 
quality goals, or want to request a paper copy of 
this information, call Cigna Customer Service at 
800.88Cigna (882.4462).

https://cignaforhcp.cigna.com/app/login
https://static.cigna.com/assets/chcp/resourceLibrary/medicalResourcesList/medicalCommitment2Quality.html
https://cignaforhcp.cigna.com/app/login
https://static.cigna.com/assets/chcp/resourceLibrary/medicalResourcesList/medicalClinicalHealthandWellness/medicalClinicalHealthCareGuidelines.html
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COORDINATION OF CARE 

NEW HEALTH DISPARITIES WEB 
PAGE ON CIGNA.COM 
A new Health Disparities web page for providers is now available on Cigna.com to offer additional 
information to help support culturally diverse patients. It is intended to help you and your staff learn more 
about health disparities, how your patients may be affected by them, and how you may address them. 

Health disparities are not new to health care, but the COVID-19 pandemic has exacerbated existing 
disparities in many subpopulations. 

Explore the Health Disparities web page today 

You will find many resources to help you and your staff understand your patients’ diverse values, beliefs, 
and behaviors, and customize treatment plans to meet their social, cultural, and linguistic needs. Go to 
Cigna.com > Health Care Providers > Provider Resources Overview > All Resources: Health Disparities.  

Other health disparity resources

The Cultural Competency and Health Equity Resources web page contains numerous other resources, 
such as a white paper on South Asian health disparities, a tool kit on gender-inclusive language 
guidelines, cultural competency eCourses, language assistance services, and more. Go to Cigna.com > 
Health Care Providers > Provider Resources > Cultural Competency and Health Equity Resources. See 
page 37 for more information.  

Coordination of care is the process by which a patient’s team of providers cooperatively help coordinate care 
management and ensure access to quality, cost-effective care.

Disruptions in care and lack of timely communication may result in delays in treatment and possibly 
poor health outcomes for patients. Through communication, planning, and collaboration, continuity and 
coordination of care can be achieved to ultimately meet the patient’s needs.
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To help facilitate continuous and appropriate care for 
patients, our quality program monitors, assesses, and 
identifies opportunities to take action and improve 
upon continuity and coordination of care across 
health care settings and between providers.

Our quality programs monitor for:

›	 Coordination of care – 

–	 During transitions between inpatient settings, 
such as hospitals, skilled nursing facilities, 
or hospice.

–	 In outpatient settings, such as rehabilitation 
centers, emergency departments, or 
surgery centers.

–	 When patients move between providers 
(for example, from a specialist to a primary 
care provider).

›	 Notification of patients and their transition 
from providers who have been terminated from 
a network.

›	 Patients who qualify for continued coverage of 
services rendered by providers who have been 
terminated from a network for reasons other 
than quality.

The National Committee of Quality Assurance 
(NCQA) is a private, nonprofit organization 
dedicated to improving health care quality. NCQA 
accredits and certifies a wide range of health 
care organizations. It also recognizes clinicians 
and practices in key areas of performance. NCQA 
is committed to providing health care quality 
information for consumers, purchasers, health 
care providers, and researchers.

We have developed tools based on our 
assessments to serve as models for exchanging 
clinical information that help facilitate continuity 
and coordination of care. The tools are available 
for download from the Cigna for Health Care 
Professionals website (CignaforHCP.com > Get 
questions answered: Resource > Medical Resources > 
Commitment to Quality > Quality > Continuity and 
Coordination of Care).

HEALTH PLAN

NCQA

AA

CC CC
RR EE DD II TT EE DD

https://www.cigna.com/health-care-providers/resources/health-disparities
https://www.cigna.com/
https://www.cigna.com/
https://www.cigna.com/health-care-providers/resources/health-disparities.html
http://www.Cigna.com
https://www.cigna.com/health-care-providers/resources/topic-cultural-competency-health-equity
https://cignaforhcp.cigna.com/web/public/guest/%21ut/p/z1/04_Sj9CPykssy0xPLMnMz0vMAfIjo8zig5zMjAwNLBy9HQPdjAw8LY08fM28PQ0NPM31wwkpiAJKG-AAjgZA_VGElBTkRhikOyoqAgA1i_EW/dz/d5/L2dBISEvZ0FBIS9nQSEh/
https://static.cigna.com/assets/chcp/resourceLibrary/medicalResourcesList/medicalcommitment2Quality/commit2QualityCnCofCare.html
https://static.cigna.com/assets/chcp/resourceLibrary/medicalResourcesList/medicalcommitment2Quality/commit2QualityCnCofCare.html
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GENERAL NEWS

RESOURCES TO SUPPORT 
YOUR CARE OF BLACK PATIENTS 
WITH DIABETES 

As a group, African Americans/Blacks experience significant health disparities with chronic conditions, such 
as diabetes, due to race and social determinants of health. This population accounts for 13.4 percent of the 
United States population,* yet they are 60 percent more likely than non-Hispanic Whites to be diagnosed 
with diabetes.** 
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DISCOUNTS FOR LANGUAGE 
ASSISTANCE SERVICES 

ELECTRONIC SIGNATURE 
CAPABILITIES EXPAND FOR 
CAC PROGRAM 

Cigna network providers may utilize discounted rates of up to 50 percent for language assistance 
services, such as interpretation and translation.

As we continue to expand our electronic signature capabilities, providers who participate in the Cigna 
Collaborative Accountable Care (CAC) COVID Care Program will receive the upcoming patient survey 
via DocuSign. This will help save time, as you will be able to electronically fill out and sign the survey, 
similarly to how you currently do for attestations, contracting, and banking. 

To ensure you receive all applicable electronic signature communications, please add  
CACCOVIDCare@Cigna.com to your safe senders list.

New online provider resources 

To support your care of African American/Black 
patients who have diabetes, you can now access 
culturally sensitive, evidence-based materials from 
Cigna’s African-American Health Disparities 
web page.*** The resources highlight strategies 
to support the unique needs of this population, 
and include provider-facing case studies, a video, 
and a guide to help your African American/Black 
patients with diabetes make the most of physician 
appointments.  

Culturally sensitive diabetic resources for 
other cultures

The creation of new diabetes resource materials for 
the African American/Black population is part of a 
multiyear project underway at Cigna that started last 
year with a focus on diabetes in the Southeast Asian 
population. The goal is to help close gaps in health 
outcomes due to race and social determinants of 
health by highlighting strategies to support the 
unique and diverse needs of various populations.  

To learn about more health disparity 
resources 

Please read the article, “New Health Disparities web 
page on Cigna.com” on page 27. 

    * U.S. Census Bureau, 2021.
  ** U.S. Department of Health and Human Services, 2021.
*** Go to Cigna.com > Health Care Providers > Provider Resources Overview > All Resources: African-American Health Disparities.

This includes written translations for your 
eligible patients with Cigna coverage, as well as 
interpretation for telephonic, face-to-face, and 
video remote interpreters, including American 
Sign Language. 

Video remote interpretation can be an effective 
communication option for obtaining a professional 
interpreter. It is often lower in cost and quicker to 
obtain than a face-to-face, in-office interpreter. 

These savings are made possible through our 
negotiated contracts with professional language 
assistance vendors. It’s important to note that 
your office will work directly with the vendor to 
schedule and pay for all language services. 

Learn more

For information about translation and 
interpretation discounts, and how to schedule 
them, go to Cigna.com > Health Care Providers > 
Provider Resources > Cultural Competency and 
Health Equity > Language Assistance Services. 

We hope these discounts will help to make it 
easier and more affordable for you to comply 
with federal and state language assistance 
laws, and ensure successful communications 
with limited English proficient, deaf, and  
hard-of-hearing patients.  

mailto:CACCOVIDCare%40Cigna.com?subject=
https://www.cigna.com/health-care-providers/resources/african-american-black-health-disparities
https://www.cigna.com/health-care-providers/resources/african-american-black-health-disparities
http://www.Cigna.com
https://www.cigna.com/health-care-providers/resources/african-american-black-health-disparities
https://www.cigna.com/
https://www.cigna.com/health-care-providers/resources/language-assistance-services
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REGIONAL NEWS

CALIFORNIA PROVIDER ACCESS 
AND AVAILABILITY 

As a provider, you want your patients to be healthy and satisfied with your care. When they receive the right 
care at the right time, it can result in better outcomes and an improved care experience for both you and 
your patient. 

The State of California Department of Managed Health Care (DMHC) has set forth guidelines to help ensure 
individuals receive timely access to medical and behavioral care based on their needs. Timely access is also 
part of your Cigna contract.

Annual Provider Appointment Access and Availability Survey 

Each year, we require network-participating providers to complete a Provider Appointment Availability Survey 
(PAAS) to help ensure compliance with the California DMHC and Cigna access standards for all care. 

Resources 

Please refer to the infographic to the right. We encourage you to use this as a visual reminder of access to 
care standards for your patients based on their needs. To learn more about California access standards, refer 
to the resources below.

RESOURCE GO TO:

Cigna Reference Guide for participating 
physicians, hospitals, ancillaries, and other health 
care providers (California).

Cigna for Health Care Professionals website 
(CignaforHCP.com) > Resources > Reference Guides 
> Medical Reference Guides > Health Care Professional 
Reference Guides > California. (Login required.)

California Department of Managed Health 
Care website

DMHC.CA.gov > Health Care in California > Your Health 
Care Rights > Timely Access to Care

1. �The Urgent and Nonurgent Care sections of this infographic are reproduced and printed with the permission of the California Department of Managed Health Care. DMHC.CA.gov > 
Health Care in California > Your Health Care Rights > Timely Access to Care. 

2. �Six hours for mental health, non-life-threatening emergency care (National Committee for Quality Assurance required access standards).
3. Examples of nonphysician mental health providers include counseling professionals, substance abuse professionals, and qualified autism service providers.
4. �Examples of nonurgent appointments for ancillary services include lab work or diagnostic testing, such as mammograms or MRIs, and treatment of an illness or injury such as 

physical therapy.

URGENT CARE

Prior authorization  
not required by health plan 

 2 days

Prior authorization  
required by health plan 

 4 days

NONURGENT CARE

Doctor Appointment

PRIMARY CARE PHYSICIAN

 10 business days

SPECIALTY CARE PHYSICIAN

 15 business days

Mental Health Appointment2

(nonphysician3)

 10 business days

Appointment
(ancillary provider4)

 15 business days

TIMELY ACCESS TO CARE1 
ALL CARE

Average wait time in the office 

 30 minutes or less

Appointment rescheduling 

 PROMPTLY
EMERGENT OR HIGH RISK

 IMMEDIATE 
Office visit, emergency room, or ambulance (call 9-1-1)

https://cignaforhcp.cigna.com/app/login
http://dmhc.ca.gov/
https://www.dmhc.ca.gov/HealthCareinCalifornia/YourHealthCareRights/TimelyAccesstoCare.aspx
https://dmhc.ca.gov/
https://www.dmhc.ca.gov/HealthCareinCalifornia/YourHealthCareRights/TimelyAccesstoCare.aspx
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REGIONAL NEWS

CALIFORNIA LANGUAGE 
ASSISTANCE LAW 

California law requires health plans to provide Language Assistance Program (LAP) services to eligible 
customers with limited English proficiency (LEP).

To support this requirement, Cigna provides language assistance services for eligible Cigna participants, 
including those covered by our California health maintenance organization (HMO), Network Open Access, 
and Network Point of Service (POS) plans, as well as for individuals covered under insured California-sitused 
preferred provider organization (PPO) plans and open access plans (OAPs).

language, a professional telephonic interpreter 
must always be offered. If the patient refuses 
to use a trained interpreter, it must be 
documented in his or her medical record.

›	 Supplying the California Customer Grievance 
Form and grievance brochure to Cigna customers 
who communicate dissatisfaction with the services 
or care received, a utilization management 
decision, or a claim denial. To download and print 
the form in English, Spanish, or Traditional 
Chinese, go to Cigna.com > I want to… > Find a 
Form > Medical Forms > Cigna in California > 
Cigna, Grievances & Appeals:

–	 Cigna Grievance Procedure > California 
Grievance Brochure

–	 How to File a Grievance > Medical 
Grievance Form

For additional information:

›	 Refer to the California edition of the Cigna Reference Guide for physicians, hospitals, ancillaries, and other 
providers by logging in to the Cigna for Health Care Professionals website (CignaforHCP.com) > Resources 
> Reference Guides > Medical Reference Guides > Health Care Professional Reference Guides.

›	 Review the California Language Assistance Program web page.* 

›	 Download the provider training presentation about LAP regulations and how to access language services 
for your patients with Cigna coverage.** 

›	 Contact your Experience Manager.

Racial and linguistic diversity at a glance

Cigna collects language preference, race, and ethnicity data for California-eligible customers.

Language

Cigna uses California demographic data as a proxy for our customer base until we have a statistically 
valid number of customer language preference records. The data listed below is currently available for 
the most non-English spoken languages in California.***

›	 44.5% of the California population (over age five) speak a language other than English.***

›	 28.8% speak Spanish.

›	 10.1% speak Asian and Pacific Island languages.

Racial and ethnic composition

The data below is an indirect estimation of Cigna's California customers. The figures were derived from 
a methodology that uses a combination of census geocoding and surname recognition.

›	 52.9% Caucasian

›	 21.8% Hispanic

›	 19.3% Asian

›	 2% African American

›	 3.98% Other

    * �Visit Cigna.com > Health Care Providers > Provider Resources > Cultural Competency and Health Equity > Language Assistance Services > Load More > California Language Assistance Program (CALAP).
  ** �Visit Cigna.com > Health Care Providers > Provider Resources > Cultural Competency and Health Equity > More Resources: California Language Assistance Program Training for Providers and Staff.
*** �2019 5-Year American Community Survey. U.S. Census Bureau. December 2019. Retrieved from https://data.census.gov/cedsci/table?q=California&t=Language%20Spoken%20at%20Home&hidePreview=false&tid=ACSST1Y2019.S1601&vintage=2018. 

Cigna LAP-eligible customers are entitled to 
the following free services:

›	 Spanish or Traditional Chinese translation of 
documents considered vital according to 
California law.

›	 Interpreter services at each point of contact, 
such as at a provider’s office or when calling 
Cigna Customer Service.

›	 Notification of rights to LAP services. 

California-capitated provider groups are 
responsible for:
›	 Inserting or including the LAP notification in 

English vital documents sent to individuals with 
Cigna HMO plan coverage.

›	 Educating providers in their practice that they 
must offer Cigna’s free telephone interpreter 
services by calling 800.806.2059 to support their 
LEP patients with Cigna coverage. Even if a 
provider or office staff speaks in the patient’s 

https://www.cigna.com/assets/docs/Cigna%20notices-of-privacy-practices/california-specific-forms/medical_grievance_form4.pdf?WT.z_nav=cignacompanynames%2Fcigna-in-california%3Baccordion%3BHow%20to%20File%20a%20Grievance%3BEnglish
https://www.cigna.com/assets/docs/Cigna%20notices-of-privacy-practices/california-specific-forms/medical_grievance_form4.pdf?WT.z_nav=cignacompanynames%2Fcigna-in-california%3Baccordion%3BHow%20to%20File%20a%20Grievance%3BEnglish
https://www.cigna.com/assets/docs/Cigna%20notices-of-privacy-practices/california-specific-forms/california-grievance-brochure.pdf?WT.z_nav=cignacompanynames%2Fcigna-in-california%3Baccordion%3BCigna%20Grievance%20Procedure%3BEnglish
https://www.cigna.com/
https://www.cigna.com/cignacompanynames/cigna-in-california?WT.z_nav=memberrightsandresponsibilities%2Fmember-forms;accordion;Medical%20Forms;Cigna%20in%20California
https://cignaforhcp.cigna.com/app/login
https://www.cigna.com/health-care-providers/resources/california-language-assistance-program
https://www.cigna.com/static/www-cigna-com/docs/health-care-providers/resources/california-assistance-learning-program-training-providers-and-staff.pdf
https://www.cigna.com/
https://www.cigna.com/health-care-providers/resources/california-language-assistance-program
https://www.cigna.com/
https://www.cigna.com/static/www-cigna-com/docs/health-care-providers/resources/california-assistance-learning-program-training-providers-and-staff.pdf
https://data.census.gov/cedsci/table?q=California&t=Language%20Spoken%20at%20Home&hidePreview=false&tid=ACSST1Y2019.S1601&vintage=2018
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REGIONAL NEWS

NEW MEXICO LANGUAGE 
ASSISTANCE LAW 

New Mexico law requires health plans to provide free language assistance services to all customers who reside in New Mexico. Cigna provides free interpreter services at all Cigna locations and provider points of contact for 
all customers in New Mexico with Cigna-administered plans (regardless of product type) who have:

›	 Limited English proficiency (LEP).

›	 Differing hearing abilities that qualify under the Americans with Disabilities Act (ADA) for sign language.

Language assistance services that providers are responsible for offering

LANGUAGE SERVICE NEEDED ACTION DETAILS

LEP patient office visit or phone calls Call Cigna's toll-free number at 800.806.2059 
for free professional over-the-phone interpreter 
services. Periodically validate with the over-the-
phone interpreter that interpretation is accurate.

Be ready to provide the patient’s Cigna ID number and date of birth. 

If telephonic interpretation services do not meet the needs of your patient in New Mexico with a Cigna-administered plan, 
you can schedule free face-to-face and video remote interpreter services, including American Sign Language (ASL), by 
calling Cigna Customer Service at 800.88Cigna (882.4462). 

For face-to-face Spanish interpreters, please allow at least three business days to schedule services. For all other languages, 
including ASL, please allow at least five business days to schedule services.

Deaf patient office visit Call Cigna Customer Service at 800.88Cigna 
(882.4462) to schedule an appointment for free 
sign language interpreter services.

Provide information about the patient’s next scheduled appointment and type of sign language service needed (e.g., ASL). 

For ASL interpreters, please allow at least five business days to schedule services.

Deaf patient telephonic service relay Call 711 Telecommunications Relay Services (TRS). The 711 TRS is a no-cost relay service that uses an operator, phone system, and a special teletypewriter (telecommunications 
device for the deaf [TDD] or teletypewriter [TTY]) to help people with hearing or speech impairments have conversations 
over the phone. The 711 TRS can be used to place a call to – or receive a call from – a TTY line.

Both voice and TRS users can initiate a call from any telephone, anywhere in the United States, without having to remember 
and dial a seven- or ten-digit access number. Simply dial 711 to be automatically connected to a TRS operator. Once 
connected, the operator will relay your spoken message in writing, and read responses back to you. In some areas, 711 
TRS offers speech impairment assistance. Specially trained speech recognition operators are available to help facilitate 
communication with individuals who may have speech impairments.1

1. Better Communication, Better Care: Provider Tools to Care for Diverse Population. Industry Collaboration Effort. March 2017. Retrieved from https://www.iceforhealth.org/library/documents/Better_Communication,_Better_Care_-_Provider_Tools_to_Care_for_Diverse_Populations.pdf.

Continued on next page 

https://www.iceforhealth.org/library/documents/Better_Communication%2C_Better_Care_-_Provider_Tools_to_Care_for_Diverse_Populations.pdf
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REGIONAL NEWS

New Mexico language assistance law continued

Racial and ethnic diversity at a glance

Cigna collects language preference, race, and ethnicity data for New Mexico 
customers.

Language

Cigna uses New Mexico demographics data as a proxy for our customer base until 
we have a statistically valid number of customer language preference records. 
Available data2 for spoken languages other than English shows that Spanish, at 
26.5 percent, is the most spoken non-English language in New Mexico.4

Racial and ethnic composition

The data below is an indirect estimation of the racial composition of Cigna's 
New Mexico customers. The data was derived from a methodology that uses a 
combination of census geocoding and surname recognition.

›	 55.1% Caucasian

›	 37.8% Hispanic

›	 1.7% Asian/Pacific 
Islander

›	 1.1% Black

›	 4.36% Other

Questions?

If you have questions about the New Mexico language assistance law or 
Cigna interpreter services, please call Cigna Customer Service at  
800.88Cigna (882.4462).

2. �13.10.22.12(I) New Mexico Administrative Code (NMAC).

3. �Cigna.com > Health Care Providers > Provider Resources > Tips for Working with a Language Interpreter. 

4. �2019 5-Year American Community Survey. U.S. Census Bureau. December 2019. Retrieved from https://data.census.gov/cedsci/table?q=new%20mexico&t=Language%20
Spoken%20at%20Home&hidePreview=false&tid=ACSST1Y2019.S1601&vintage=2018. 

Language assistance services that providers are responsible for offering (continued)

LANGUAGE SERVICE 
NEEDED

ACTION DETAILS

Refusal of service: An 
LEP or deaf patient wants 
to use a family member or 
friend to interpret

OR

An LEP patient wants 
to speak with bilingual 
office staff.

Offer a telephonic interpreter to 
the LEP patient. Discourage the use 
of family and friends – especially 
minors – as interpreters. 

Offer a trained, qualified telephonic 
interpreter, even if a provider or 
office staff speaks in the patient’s 
language.

If a patient insists on using a family member or friend, or 
refuses to use a trained interpreter, document this in his or 
her medical record.

Language assistance services that Cigna is responsible for offering

LANGUAGE SERVICE 
NEEDED

ACTION DETAILS

LEP customer telephonic 
communication at Cigna 
point of contact

Customers call the telephone 
number on the back of their Cigna 
ID card for access to Cigna bilingual 
staff and free interpreter services.

Cigna uses qualified professional interpreters and bilingual 
staff tested for proficiency in language and health care 
terminology in non-English languages.

Deaf or hard-of hearing 
telephonic communication 
at Cigna point of contact

Customers dial 711 for TRS. Cigna staff follow department workflows to communicate 
with deaf or hard-of-hearing customers.

LEP customer telephonic 
and in-person interpreter 
services at provider point 
of contact

Customers have access to these 
services at the provider's office at 
no cost to the provider.2

Each contract requires the health care insurer or managed 
health care plan to provide interpreters for LEP individuals, 
and interpretative services for patients who qualify under 
the ADA.

Refer to Tips for Working with a Language Interpreter3 for 
more information.

https://www.cigna.com/
https://www.cigna.com/health-care-providers/resources/tips-language-interpreter
https://data.census.gov/cedsci/table?q=new%20mexico&t=Language%20Spoken%20at%20Home&hidePreview=false&tid=ACSST1Y2019.S1601&vintage=2018
https://data.census.gov/cedsci/table?q=new%20mexico&t=Language%20Spoken%20at%20Home&hidePreview=false&tid=ACSST1Y2019.S1601&vintage=2018
https://www.cigna.com/health-care-providers/resources/tips-language-interpreter
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MARKET MEDICAL EXECUTIVES 
CONTACT INFORMATION 

HELPFUL REMINDERS
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NORTHEAST REGION 
Peter McCauley, Sr., MD, CPE, Regional Medical Executive 312.648.5131
Jennifer Daley, MD MA, ME, NH, RI, VT 617.831.2254
Catherine Dimou, MD, FACP IL, IN, MI, MN, WI 312.496.5403
Vaishali Geib, MD DC, MD, VA 804.904.5791
Jeffrey Langsam, DO CT 860.226.8004
Tiffany Lingenfelter-Pierce, MD MA, ME, NH, RI, VT 603.203.4317
Ronald Menzin, MD NJ, NY 804.904.4090
E. Dave Perez, MD NJ, NY 646.265.4916
Laura M. Reich, DO DE, OH, PA, WV 443.553.6502
Christina Stasiuk, DO, FACOI DC, MD, VA 215.761.7168
TBD IA, KS, MO, ND, NE, SD TBD
SOUTHEAST REGION 
Michael Howell, MD, MBA, FACP, Regional Medical Executive 407.607.4115
Raj Davda, MD NC, SC 704.962.0987
Robert Hamilton, MD AL, GA 404.443.8820
Michael Howell, MD, MBA, FACP Central FL, North FL, USVI    407.607.4115
James Lancaster, MD AR, KY, MS, TN 615.595.3124
John Leslie, MD AR, MS, West TN 901.208.5705
Mark Netoskie, MD, MBA, FAAP LA, South TX 713.576.4465
Marco Vitiello, MD Southern FL 954.514.6705
Frederick Watson, DO, MBA, CPE OK, North TX 972.863.5119
WEST REGION 
Jennifer Gutzmore, MD, Regional Medical Executive 818.500.6459
Leslie Barakat, MD, MBA AZ 480.532.5498
Laura Clapper, MD Southern CA, NV 619.359.9241
Richard Hourigan, MD, MHA, FAAFP AK, ID, MT, OR, WA 571.401.5113
Jeffrey Klein, MD, FAAFP Southern CA, NV 818.482.6051
Mark Laitos, MD CO, NM, WY 720.442.4817
Kenneth Phenow, MD Northern CA 336.202.6826
Douglas Smith, MD, MBA UT 385.285.5520
Rodgers Wilson, MD AZ 480.721.9036

NATIONAL
Peter McCauley, Sr., MD, CPE 

Clinical Provider Engagement &  
Value-Based Relationships

Jennifer Gutzmore, MD 

Clinical Strategy & Solutions

312.648.5131

818.500.6459

Reasons to call your MME 
	› 	 Ask questions and obtain general information 

about our clinical policies and programs. 

	› 	 Ask questions about your specific practice 
and utilization patterns. 

	› 	 Report or request assistance with a quality 
concern involving your patients with 
Cigna coverage. 

Cigna Market Medical Executives (MMEs) are an important part of our relationship with providers. They 
provide a unique level of personalized support and service within their local regions. Your local MME 
understands local community nuances in health care delivery, can answer your health care-related 
questions, and is able to assist you with issues specific to your geographic area.

	› 	 Request or discuss recommendations 
for improvements or development of 
our health advocacy, affordability, or 
cost‑transparency programs. 

	› 	 Recommend specific physicians or facilities 
for inclusion in our networks, or identify 
clinical needs within networks. 

	› 	 Identify opportunities to enroll your patients 
in Cigna health advocacy programs. 
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HOW TO CONTACT US 

When you’re administering plans for your patients with Cigna-administered coverage and have questions, 
who do you contact? In a few clicks, you can quickly find this information by checking out the Cigna 
Important Contact Information* or Medicare Advantage Provider Quick Reference Guide.**

These guides contain links, email addresses, and phone numbers that can help you administer these plans 
more efficiently, and supplement your efforts to render an optimal patient experience. We encourage you to 
bookmark them for easy access to the most up-to-date information.  

HELPFUL REMINDERS
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USE THE NETWORK 

CIGNA REFERENCE GUIDES 

Help your patients keep medical costs down by 
referring them to providers in our network. Not 
only is that helpful to them, but it’s good for 
your relationship with Cigna, as it’s required in 
your contract. There are exceptions to using the 
network – some are required by law, while others 
are approved by Cigna before you refer or treat 
the patient. 

Additionally, your contract with Cigna requires 
you to use pharmacies in the Cigna network 
for specialty medications, including injectable 
medications, whenever possible. Accredo, a Cigna 
company, is a nationwide pharmacy for specialty 
medications and can be used when medically 
appropriate. 

Of course, if there’s an emergency, use your 
professional discretion. 

Referral reminder: New York and Texas

If you are referring a patient in New York or Texas 
to a nonparticipating provider (e.g., laboratory, 
ambulatory surgery center), you are required to 
use the appropriate Out-of-Network Referral  
Disclosure Form.

›	 New York providers

›	 Texas providers

For a complete list of Cigna-participating 
physicians and facilities, go to Cigna.com >  
Find a Doctor, Dentist or Facility. Then, select  
a directory. 

The Cigna Reference Guides for participating 
physicians, hospitals, ancillaries, and other 
providers contain many of our administrative 
guidelines and program requirements. They 
include information pertaining to participants 
with Cigna and “G” ID cards.

Access the guides

You can access the reference guides by logging 
in to the Cigna for Health Care Professionals 
website (CignaforHCP.com) > Resources > 
Reference Guides > Medical Reference Guides > 
Health Care Professional Reference Guides. You 
must be a registered user to access this website. 
If you are not registered, click Register.

Cigna Medicare Advantage 
provider manuals 

If you are a network-participating provider for 
Cigna Medicare Advantage plans, you may 
reference our provider manuals for Medicare 
Advantage, which contain important information 
concerning our policies, procedures, and other 
helpful information. You can access the manuals at 
MedicareProviders.Cigna.com > Provider Manuals.

  * CignaforHCP.com > Get Questions Answered: Resource > Medical Resources > Communications > Contact Us.
** MedicareProviders.Cigna.com > Provider Resources: Provider Quick Reference Guide.

https://static.cigna.com/assets/chcp/pdf/resourceLibrary/medical/importantContactInformation.pdf
https://static.cigna.com/assets/chcp/pdf/resourceLibrary/medical/importantContactInformation.pdf
https://medicareproviders.cigna.com/static/medicareproviders-cigna-com/docs/provider-quick-reference-guide.pdf
https://www.cigna.com/static/www-cigna-com/docs/out-of-network-referral-disclosure-form.pdf
https://www.cigna.com/static/www-cigna-com/docs/texas-out-of-network-referral-disclosure-form.pdf
https://www.cigna.com/
https://hcpdirectory.cigna.com/web/public/consumer/directory
https://cignaforhcp.cigna.com/app/login
https://cignaforhcp.cigna.com/app/registration/lob
https://medicareproviders.cigna.com/
https://cignaforhcp.cigna.com/app/login
https://static.cigna.com/assets/chcp/pdf/resourceLibrary/medical/importantContactInformation.pdf
https://medicareproviders.cigna.com/
https://medicareproviders.cigna.com/static/medicareproviders-cigna-com/docs/provider-quick-reference-guide.pdf
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HELPFUL REMINDERS

The Quick Guide to Cigna ID Cards contains 
samples of the most common customer ID cards, 
along with detailed line-item information. You can 
view it using our online interactive ID tool or as 
a PDF. 

To access the guide

›	 Go to Cigna ID Cards.* You’ll see sample 
images of the most common ID cards.

›	 To view only the cards for certain plan types, 
click Filter Cards by Category and select one or 
more plan types – such as Managed Care Plans, 
Individual & Family Plans, or Strategic Alliance 
Plans – from the categories that appear.

›	 Choose the image that matches your patient’s 
ID card; the selected sample ID card will appear.

›	 Hover over each number shown on the card for 
more details about that section, or read the key 
on the right-hand side of the screen.

›	 Click View the Back to see the reverse side 
of the card.

›	 Click About This Plan to read more about 
the plan associated with this ID card.

›	 Click View Another Card Type to view a 
different sample ID card.

Other information you can access
On every screen of the ID card tool, you can 
click a green tab for more information about:

›	 The myCigna® App.**

›	 More ways to access patient information 
when you need it.

›	 Important contact information.

Use the digital ID card tool.

  * Go to Cigna.com > Health Care Providers > Coverage and Claims > Coverage Policies: ID Cards
** �	The downloading and use of the myCigna App is subject to the terms and conditions of the App and the online stores from which it is downloaded. Standard mobile phone 

carrier and data usage charges apply.

QUICK GUIDE TO CIGNA ID CARDS  
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As a reminder, verified patient reviews* display in 
providers’ profiles in the myCigna.com directory. 
New reviews are published on an ongoing basis.  

Reviews are verified 

A Cigna customer is only sent a survey – and can 
only leave a review for a provider – after a claim has 
been processed for care received from that provider. 
This verifies that the review is from a provider’s 
actual patient. We anticipate that customers will 
value these verified patient reviews over unverified 
reviews from third-party websites, and use them as a 
trusted source when choosing health care providers.  

How patient reviews works 

After a preventive care or routine office visit, 
customers may receive an email with a single 
question that asks about their recent health care 
experience. Customers are also able to leave reviews 
from the Claims Summary and Claims Detail pages 
on myCigna.com. Their response (or “review”) is 
vetted to ensure it meets certain editorial guidelines. 
For example, the language cannot violate protected 
health information rules or contain profanity. 
Reviews that meet the guidelines will be published in 
the myCigna.com directory.

* 	For U.S. customers only.

Who receives reviews?  

Patient reviews are available in our online directory 
for both network-participating and nonparticipating 
providers in all specialties. 

How to access your reviews  

	› 	 Log in to the Cigna for Health Care Professionals 
website (CignaforHCP.com). If you are 
not a registered user of the website, go to 
CignaforHCP.com > Register.  

	› 	 Under Latest Updates, view your patient reviews 
and click “Learn more” for instructions.  

	› 	 You will be instructed to ask your practice’s 
website access manager for access to 
patient reviews.

Once your website access manager grants you 
(or the staff member you designate) access to the 
reviews, you can view them at any time by logging 
in to CignaforHCP.com > Working with Cigna > 
Patient Reviews.

PATIENT REVIEWS REMINDERS  

https://www.cigna.com/healthcare-professionals/resources-for-health-care-professionals/idct/
https://www.cigna.com/healthcare-professionals/resources-for-health-care-professionals/idct/
https://www.cigna.com/
https://www.cigna.com/healthcare-professionals/resources-for-health-care-professionals/idct/
https://my.cigna.com/
https://my.cigna.com/
https://my.cigna.com/
https://cignaforhcp.cigna.com/app/login
https://cignaforhcp.cigna.com/app/login
https://cignaforhcp.cigna.com/app/registration/lob
https://cignaforhcp.cigna.com/app/login
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HELPFUL REMINDERS

People often visit emergency rooms for non-life-threatening situations, even though they usually pay 
more and wait longer. Why? Because they often don’t know where else to go. 

You can give your patients other, often better, options. Consider providing them with same-day 
appointments when it’s an urgent problem. And when your office is closed, consider directing them 
to a participating urgent care center rather than the emergency room, when appropriate.

For a list of Cigna’s participating urgent care centers, view our Provider Directory at Cigna.com > 
Find a Doctor, Dentist or Facility. Then, choose a directory.

URGENT CARE FOR 
NONEMERGENCIES 
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VIEW DRUG BENEFIT DETAILS 
USING REAL-TIME BENEFIT CHECK 
Real-time benefit check gives you access to patient-specific drug benefit information through your 
electronic medical record (EMR) or electronic health record (EHR) system during the integrated 
ePrescribing process. If you are a provider treating military beneficiaries, you also have access to 
patient-specific drug benefit information through your EMR or EHR system. 

This service enables you to access drug benefit details, including: 

›	 Cost share. 

›	 Therapeutic alternatives with cost shares. 

›	 Coverage status (e.g., prior authorization, step therapy, quantity limits). 

›	 Channel options (i.e., 30- and 90-day retail, and 90-day mail). 

EMR or EHR system requirements

To access real-time benefit check, you must have the most current version of your vendor’s EMR or 
EHR system, and the system must be contracted with Surescripts®. For more information and to get 
started, contact your EMR or EHR vendor.

TRANSFORMATIONS BEHAVIORAL 
HEALTH DIGITAL NEWSLETTER
Check out the latest issue of Transformations, Cigna’s digital newsletter for behavioral providers. 
Whether you want to stay informed about behavioral health services and specialties that may 
be available to your patients, or learn more about Cigna resources to support the mind-body 
connection, you’ll find it here.

https://www.cigna.com/
https://hcpdirectory.cigna.com/web/public/consumer/directory
https://www.cigna.com/transformations
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HELPFUL REMINDERS

CAREALLIES  
EDUCATION SERIES 

CareAllies®, a Cigna business, continues to help increase your  
value-based care knowledge through Valuable Insights, a free,  
online education series. This series enables you to: 

	› 	 Earn AMA PRA* Category 1 CreditsTM with Valuable Insights  
on-demand webcasts.** 

	› 	 Learn quickly and on the go with Valuable Insights podcasts. 

	› 	 Get industry updates from subject matter experts with Valuable 
Insights alerts. 

To obtain access to Valuable Insights, including past resources and 
notifications when new resources are posted, visit the Valuable Insights 
registration page. If you have questions, email info@CareAllies.com.

  * American Medical Association Physician’s Recognition Award. 
** �This activity has been planned and implemented in accordance with the accreditation requirements and policies of the 

Accreditation Council for Continuing Medical Education (ACCME) through the joint providership of the Illinois Academy of 
Family Physicians and CareAllies. 
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RESOURCES TO ENHANCE INTERACTIONS WITH 
CULTURALLY DIVERSE PATIENTS 
If you serve a culturally diverse patient 
population, check out the Cigna Cultural 
Competency and Health Equity Resources 
web page. It contains many resources 
to help you and your staff enhance your 
interactions with these patients. The website 
is easy to navigate, streamlined to help you 
find the information you need quickly, and 
mobile friendly. 

Listed below are some of the resources 
available to Cigna-contracted providers.

White paper: South Asian Health 
Disparities

Increase your awareness about health 
disparities in the South Asian population, 
contributing factors, and how you can help 
reduce these disparities. This white paper 
may help you to adapt your communication 
style to address cultural nuances, ultimately 
improving health outcomes.

Communication tool kit: Gender-
inclusive language guidelines 

This helpful one-page tool kit shares 
concrete examples of gender-inclusive 
language, an important aspect of delivering 
culturally responsive care in alignment with 
the National Standards for Culturally and 
Linguistically Appropriate Services (CLAS) 
in Health and Health Care. It will also help 
you to be compliant with Section 1557 of the 
Affordable Care Act (ACA). 

eCourses 

We offer a variety of eCourses that can 
help you develop cultural competency 
overall best practices and gain a deeper 

understanding of subpopulations in the 
United States. Some of the eCourses we 
offer include:

	› 	 Developing Cultural Agility (addressing 
unconscious bias).

	› 	 Developing Culturally Responsive Care: 
Hispanic Community (three-part series).

	› 	 Gender Disparities in Coronary Artery 
Disease and Statin Use.

Language assistance services

Cigna-contracted providers may obtain 
discounted rates of up to 50 percent for 
language assistance services – such as 
telephonic and face-to-face interpretations, 
as well as written translations – for their 
eligible patients with Cigna coverage. 
These savings are made possible through 
our negotiated contracts with professional 
language assistance vendors. Your office 
works directly with the vendor to schedule 
and pay for services.

California Language Assistance 
Program

Providers in California may access the 
California Language Assistance Program 
for Providers and Staff. The training 
includes education on California Language 
Assistance Program regulations, provider 
responsibilities, how to access language 
services for your patients with Cigna 
coverage, and more.  

CultureVision (available until 
December 31, 2021)

As a practitioner, it’s impossible to know 
everything about every cultural community 

you serve. However, learning what to ask 
may increase the likelihood that you will 
obtain the information you need, and 
enhance rapport and adherence. Gain these 
insights through CultureVisonTM, which 
contains culturally relevant patient care for 
more than 60 cultural communities. Go to:

CRCultureVision.com 
Login: CignaHCP 
Password: HealthEquity2021!

Additional resources

Many other resources are available on the 
Cigna Cultural Competency and Health 
Equity Resources web page, including 
articles, presentations, podcasts, and  
self-assessments. You can find them in 
the All Resources section of the web 
page. We've also added a new web page 
dedicated to Health Disparities, including 
COVID-19 health disparities. (See page 27 
for more information.)

Visit today

Go to Cigna.com > Health Care Providers > 
Provider Resources > Cultural Competency 
and Health Equity. Check back often for 
newly added resources.

https://www.careallies.com/
http://events.careallies.com/ValuableInsights%3Fsource%3DCigna
http://events.careallies.com/ValuableInsights%3Fsource%3Dcigna
mailto:info%40CareAllies.com?subject=
https://www.cigna.com/health-care-providers/resources/topic-cultural-competency-health-equity
https://www.cigna.com/health-care-providers/resources/topic-cultural-competency-health-equity
https://www.cigna.com/static/www-cigna-com/docs/health-care-providers/resources/south-asian-health-disparities-white-paper-final.pdf
http://www.iceforhealth.org/library/documents/Guidelines_for_Gender_Inclusive_Language_ICE_Approved.docx
https://www.cigna.com/health-care-providers/resources/cultural-competency-training
https://www.cigna.com/health-care-providers/resources/language-assistance-services
https://www.cigna.com/static/www-cigna-com/docs/health-care-providers/resources/california-assistance-learning-program-training-providers-and-staff.pdf
https://www.cigna.com/static/www-cigna-com/docs/health-care-providers/resources/california-assistance-learning-program-training-providers-and-staff.pdf
https://www.crculturevision.com/
https://www.cigna.com/health-care-providers/resources/topic-cultural-competency-health-equity
https://www.cigna.com/health-care-providers/resources/topic-cultural-competency-health-equity
https://www.cigna.com/health-care-providers/resources/health-disparities.html
http://www.cigna.com/
https://www.cigna.com/health-care-providers/resources/topic-cultural-competency-health-equity
https://www.cigna.com/health-care-providers/resources/topic-cultural-competency-health-equity
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Check your listing in the Cigna  
provider directory

We want to be sure that Cigna customers have 
the right information they need to reach you when 
seeking medical care. We also want to accurately 
indicate whether you are accepting new patients.

It’s easy to view and submit demographic 
changes online

	› 	 Log in to the Cigna for Health Care Professionals 
website (CignaforHCP.com) > Working With 
Cigna.

	› 	 Go to the Update Demographic Information 
section and click Update Health Care  
Professional Directory.

If you don’t see this option, ask your website 
access manager to assign you access to the 
functionality to make updates. If you don’t know 
who your website access manager is, log in to 
CignaforHCP.com > Click on the drop-down arrow 
next to your name in the upper right-hand side of 
the screen > Settings and Preferences > Online 
access > View TIN access. Select your TIN; the 
name of your website access manager(s) will be 
provided at the bottom of the screen.

	› 	 An online Provider Demographic Update Form 
will appear. It will be prepopulated with the 
information for your practice that currently 
displays in our provider directory. You can easily 
review the prepopulated fields, determine if 
the information is correct, make any necessary 
changes, and submit the form to us electronically.

Update your email address to continue 
receiving Network News and alerts

Please make sure your email address is updated  
so that you won’t miss any important 
communications, such as Network News, alerts,  
and other emails. It only takes a moment. Simply  
log in to CignaforHCP.com > Settings and 
Preferences to make the updates. You can also 
change your phone number, job role, address,  
and password here.

HELPFUL REMINDERS

HAVE YOU MOVED RECENTLY?  
DID YOUR PHONE NUMBER CHANGE?

https://cignaforhcp.cigna.com/app/login
https://cignaforhcp.cigna.com/app/login
https://cignaforhcp.cigna.com/app/login
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Would you like to reduce paper 
use in your office? Sign up now to 
receive certain announcements and 
important information from us right 
to your inbox.   

When you register for the Cigna for 
Health Care Professionals website 
(CignaforHCP.com), you can:   

	› 	 Share, print, and save – 
electronic communications 
make it easy to circulate copies. 

	› 	 Access information anytime, 
anywhere – view the latest 
updates and time-sensitive 
information online.  

When you register, you will 
receive some correspondence 
electronically, such as Network 
News.* You will still receive 
certain other communications 
by regular mail.  

If you are a registered user, please 
check the My Profile page to make 
sure your information is current. 
If you are not a registered user 
but would like to begin using the 
website and receive electronic 
updates, go to CignaforHCP.com 
and click Register.

HELPFUL REMINDERS

GET DIGITAL ACCESS 
TO IMPORTANT 
INFORMATION   

All Cigna products and services are provided exclusively by or through operating subsidiaries of Cigna Corporation, including Cigna Health and Life Insurance Company, Connecticut General Life Insurance Company, Cigna Behavioral Health, Inc., and HMO or service company 
subsidiaries of Cigna Health Corporation. The Cigna name, logo, and other Cigna marks are owned by Cigna Intellectual Property, Inc. All pictures are used for illustrative purposes only.

956212  07/21   PCOMM-2021-543     © 2021 Cigna. Some content provided under license. 

ACCESS THE ARCHIVES 
To access articles from previous issues of Network News, visit Cigna.com > Health Care Providers > Provider Resources > Cigna Network 
News for Providers.

LETTERS TO THE EDITOR
Thank you for reading Network News. We hope you find the articles informative, useful, and timely, and that you’ve explored our 
digital features that make it quick and easy to share and save articles of interest.

Your comments or suggestions are always welcome. Please email NetworkNewsEditor@Cigna.com or write to Cigna, Attn: Provider 
Communications, 900 Cottage Grove Road, Routing B7NC, Hartford, CT 06152.
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* QualCare network providers must sign up to receive Network News electronically at Cigna.com/NetworkNews.

https://cignaforhcp.cigna.com/app/login
https://cignaforhcp.cigna.com/app/login
https://cignaforhcp.cigna.com/app/registration/lob
https://www.cigna.com/
https://www.cigna.com/health-care-providers/resources/newsletters/network-news
https://www.cigna.com/health-care-providers/resources/newsletters/network-news
mailto:NetworkNewsEditor%40Cigna.com?subject=
https://www.cigna.com/health-care-providers/resources/newsletters/network-news

